Chapter 5

Soil Analysis

The Innov-X analyzer can be used to analyze in situ (directly on the ground), bagged or prepared soil
samples. A guide to Soil analysis using field portable X-ray fluorescence is found in the appendix. This
document summarizes EPA Method 6200 which is the standard protocol for field screening. It also
provides information on prepared sample testing.

5.0 CHECK STANDARDS
It is recommended that a check standard is measured after each standardization, and periodically
throughout the day. Innov-X provides several NIST certified standards for verification. The certified
values for these samples are provided in the appendix. At least one standard should be measured for a
minimum of 1 minute. Elemental concentrations for elements of interest plus or minus the error on the
reading should be within 20% of the standard value. The Field screening guide in the appendix describes
in more detail recommended quality assurance considerations.
The standards provided with the XRF analyzer are contained in XRF sample cups with a Mylar window
(through which the soil can be viewed) on one side, and a solid cap on the other side. Samples should be
measured in the sample cup, through the Mylar window. The best way to measure a prepared sample is
using the test stand. If this is not available, the sample may be placed on the ground, and the analyzer may
be pointed downwards in full contact with the soil cup. Do not hold the soil cup in your hand while
measuring.

5.1 SAMPLE PRESENTATION
In situ testing:
In situ testing is performed by pointing the analyzer at the ground. Any grass or large rocks should be
cleared away and the analyzer should be held such that the front of the probe head is held flush to the
ground.
Since dirt can accumulate on the analyzer window, it is recommended that the window is wiped clean after
each analysis. The window should also be checked to ensure it is not ripped or punctured. Instructions for
replacing the window are found in the appendix.

Bagged or prepared sample testing:
It is strongly recommended that all prepared samples be analyzed in the testing stand. Samples should be
placed on top of the testing stand, completely covering the window. Never hold prepared or bagged
samples while testing, as this could expose the operator to the x-ray beam.
Avoid measuring very thin samples, as this can affect results. Prepare samples cups to contain at least 0.5
inches of packed samples. When analyzing bagged samples, make sure that sufficient sample exists in the
bag to completely cover the window with a sample thickness of a minimum of 0.5 inches.

5.2 TESTING IN SOIL MODE
After the instrument has been standardized, testing can begin. Simply pull the trigger or press Start on the
iPAQ screen to begin the test. The red warning light on the top of the instrument will blink, indicating Xrays are being emitted. The screen will display the words “Test in progress” and the time elapsed. The
word “Testing” will blink on and off in the low right hand corner of the screen.
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After a minimum time has elapsed,
intermediate results will be
displayed on the screen. Until this
minimum time has elapsed, the
words “WAITING FOR DATA”
will appear instead. This minimum
time can be set by the user by
selecting Options→Set Testing
Times, which is described in
Section 5.4: Soil Mode Options.
Each line of the results display
shows the name of an element, its
calculated concentration and the
error on the measurement. This
error is the 1 sigma error on the
counting statistics of the
measurement. The error will
decrease with increased testing time.
Too many elements are measured in soil mode to display them at one
time. However, is possible to use the scroll bar located to the right of
the chemistry display to view other elements. The complete display
shows detected elements first, listed in order of emission line energy,
from lowest to highest. Following the detected elements are the
elements which are below the detection limit of the instrument. These
elements are shown as less than a calculated LOD. This LOD is
defined as three times the error on the counting statistics of the
measurement.
When the measurement is complete the results screen will open,
displaying the final results of the measurement.

5.3 SOIL RESULTS SCREEN
5.3.1 Results View Menu
The standard Soil Mode results
screen displays the concentration
(in ppm) and error in
measurement for detected
elements, followed by the list of
non-detected elements with the
calculated limit of detection for
each element for that test. If the
display does not show soil
chemistry results, change the
display by selecting
View→Results.
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The standard soil chemistry display can be modified by using the View Menu. As with all Innov-X
analytical modes, it is possible to view spectra and Test Information.

5.3.2 Spectrum Screen
This screen displays a plot of the x-ray fluorescence spectrum for an
individual test, plotting the intensity on the y-axis versus the energy of
the fluorescence x-rays on the x-axis.
Tapping on the spectra will show the energy scale and counts rate at
the selected point

It is possible to zoom in on certain
areas of the graph by selecting
one corner and drawing out the
region
Tapping the symbol in the upper
right hand corner beneath the X
will restore the graph to full scale.

5.3.3 Test Info Screen
The test information screen shows any test information that was entered prior to the start of the test.
Changes to that test information can be made by selecting Edit→Test Information.

5.4 SOIL MODE OPTIONS
The length of tests in Soil Mode is user settable. Users may select a minimum testing time, and as well as
choose from a variety of test end conditions.
The options related to test time are contained in two menus: Options→Set Testing Times, and
Options→Set Test End Condition. Set Testing Times contains minimum and maximum testing time
information, while Set Test End Condition allows the user to select test end conditions.

5S-3

Innov-X User Manual Version 2.1

5.4.1 Set Testing Times
To set the minimum and maximum test lengths, select Options→Set
Testing Times

A screen appears prompting you to enter a Minimum and Maximum
Testing times. Instruments equipped with the optional LEAP package
will be able to set Light Element Testing times in this screen, as well.

The minimum testing time is the required time that must elapse before results can be calculated. Live
Update results will not be displayed on the screen until the minimum has elapsed, likewise a test must
complete the minimum time before any test end condition can be used. If a test is stopped before the
minimum testing time has elapsed, the test will be aborted, and no results will be calculated.
Maximum testing time is relevant only if “Maximum Testing Time” is selected from Set Test End
Condition. This will automatically end the test at a preset testing time. Typically, the maximum testing
time will be in excess of 30 seconds, and may be 1 or 2 minutes, depending on detection limits and desired
precision.
It should be noted, that all testing times in this section refer to “Real Time,” the time the measurement takes
when timed on a normal clock. The time stored with each analytical result (accessible by selecting
View→Test Information from the Results screen), refers to the test’s “Live Time”. This is the amount of
time that the analyzer hardware was collecting spectra. Since there is some detector dead time associated
with a measurement, the live time of a test will be slightly shorter than the preset “Real time”.

5.4.2 Soil Mode Test End Condition
Four options exist for the test end criteria in soil mode. Depending on your application, you may choose to
end the test manually, at a preset testing time, or when the uncertainty in the measurement is within a

5S-4

Innov-X User Manual Version 2.1

specified relative standard deviation of the reading. Additionally, you can set up an action level for a single
element. As soon as the measuring statistics are good enough to ensure that that the reading is above,
below or at the action level, the test will end automatically. This allows for very rapid tests for elements
that are well above or below an action level.
In all modes, pressing Stop, or pulling the trigger will end the test. If the minimum testing time has
elapsed, results will be calculated. Otherwise the test will be aborted without calculating results.
Changes to the test end condition are made by selecting Options→Set
Test End Condition
The currently selected end condition will be displayed at the bottom
of the screen above the Start button on the Ready To Test screen.

Manual: This option allows you to look at the results which are
being continually updated on the screen and determine when the
results look satisfactory. The test will continue until the trigger is
pulled, or Stop is tapped on the iPAQ screen. Results will be
calculated if the testing time has exceeded the Minimum Test time
which is set up in Options→Set Testing Times. In order to preserve
battery life, the software will stop if the testing time exceeds 300
seconds, since there is little to no advantage to continuing a test
beyond 300 seconds.
To use Manual Test End Condition, simply choose Options→Set Test
End Condition and select Manual. Press OK to return to the analysis
screen.

Maximum Time: If Maximum Time is selected, the test will continue
until the preset time is reached. This is useful if you wish to do a set
of measurements with the same testing time.
To choose to end test based on a maximum time, select Options→Set
Test End Condition and select Maximum Time. Enter the desired
testing time in the appropriate box. Tap OK to save your selections.
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Action Level: System ends test when result for target analyte
including chosen precision level is above or below pre-set action
level.
To choose to end a test based on an Action Level, select Options→Set
Test End Condition and select Action Level. Select a target analyte,
specify an action level in ppm, and a confidence level. This
confidence level refers to the number of sigma required for the
precision. This should typically be set to 2. Tap OK to save your
selections.

Relative Standard Deviation (RSD): When RSD is selected as a test
end criteria, the system will end a test when the relative standard
deviation on a target analyte reaches a pre-set level. This standard
deviation is specified as a percentage of the reading. For example, if
the measured value for an analyte was 1000 ppm, and the RSD was
set to 10, the reading would stop when the error reached 100 ppm, or
10% of 1000.
To choose to end a test based on a Relative Standard Deviation, select
Options→Set Test End Condition and select Rel. Std. Dev (%).
Select a target analyte and the desired Relative Standard Deviation.
Tap OK to save your selections.

5.5 LEAP Mode (Light Element Analysis Program):
This is a factory installed optional module. Instruments can be upgraded to LEAP capabilities. Please
contact the Innov-X Systems Sales department for information and pricing.
The LEAP module provides the lowest possible detection limits for elements lighter than iron. The
standard LEAP package includes the elements Ti, Ba and Cr. Elements as low as Phosphorus can be
detected with the Advanced LEAP package which includes a thin window detector.
The standard x-ray beam conditions used by Innov-X environmental analyzers are designed to provide
good excitation for a wide range of detected elements. However it is not possible to select one beam
condition which provides the absolute best excitation conditions for all elements of interest. Elements such
as Chromium produce lower energy x-rays then other elements analyzed. These lower energy x-rays are
not as effectively excited by the standard conditions. LEAP works by changing the X-ray tube beam
conditions to settings which are optimized for the detection of elements lighter than iron. Instruments are
factory calibrated with the LEAP beam conditions for all applicable elements.
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5.5.1 LEAP Settings
To activate LEAP, select
Options→LEAP Settings from
the Soil analysis screen. This
brings up the menu shown below
on the right.

Standard Test Only: The analyzer will provide analysis for the standard suite of elements.
Light Element Analysis Only: The analyzer will provide analysis for elements in the LEAP suite
(Typically Ti, Ba and Cr)
Sequential Testing: When sequential testing is selected, all tests will start with an analysis of elements in
the standard suite. If that test ends due to reaching the selected end condition of Maximum Test Time,
Action Level, or RSD, then the analyzer will immediately begin a second test analyzing the LEAP suite of
elements. At the conclusion of this test, the Results screen will open with two new entries. The first
summarizes the standard test results, while the second summarizes the LEAP results. For safety reasons,
the second test will not begin if the test ends due to user intervention (pulling the trigger or hitting Stop). In
this case, the Results screen will open with only one reading.
If Light Element Analysis Only is
activated, the words “Light
Element Analysis Mode” will
appear above the currently
selected End Condition.
Instrument operation in this mode
is identical to Standard (NonLEAP) analysis. Tests can be
started or stopped either by
pulling the trigger, or by tapping
the Start/Stop button on the iPAQ
screen. The results screen for a
test will show results for all
elements analyzed with the LEAP
mode.
Test in progress screen, LEAP
Only, Live Updates on

Results Screen Showing LEAP
results
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If Sequential testing is selected,
the words “Sequential – Current
Test: Standard” will appear above
the currently selected End
Condition. When a test is started,
the instrument will appear to
operate in the same manner as a
Standard test. However, if the test
ends according to the specified
end condition (excluding
Manual), the results screen will
not open. Instead, the timer will
reset to 0, and the description of
the current test will change from
“Standard” to “LEAP”. The live
update screen will begin to show
analysis for all LEAP elements.

Test in progress screen,
Sequential.
First Test – Standard Analysis.

Test in progress screen,
Sequential.
Second Test – LEAP Analysis

5.5.2 Testing Times
To set the minimum and maximum test lengths for LEAP analysis,
select Options→Set Testing Times.
The testing time screen includes an extra section labeled “Light
Element Test” that is not found on non-LEAP systems. These are the
minimum and maximum test lengths for any LEAP tests.

As with standard tests, the minimum testing time is the required time that must elapse before results can be
calculated. Live Update results will not be displayed on the screen until the minimum has elapsed, likewise
a test must complete the minimum time before any test end condition can be used. If a test is stopped
before the minimum testing time has elapsed, the test will be aborted, and no results will be calculated.
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Ludlum Model 14C
GENERAL INFORMATION
Equipment Name:

Ludlum Model 14C Meter

Model:

Model 14C Meter equipped with Model 44-9 Geiger-Mueller Pancake Probe

Manufacturer:

Ludlum Measurements, Inc

Manufacturer
Contact:

Telephone: 800-622-0828
E-mail:
ludlum@ludlums.com

SPECIFICATIONS
Uses:

The Ludlum® Model 14C Geiger Counter monitors radiation with either a thin wall Geiger-Meuller (G-M)
tube detector or a pancake G-M detector. The instrument can be used with certain Model 44 series detectors
for measurement of alpha, beta or gamma radiation. The meter scale used (either CPM or mR/hr) will depend
on what detector is used with the instrument.

Limitations:

1. Instrument provides no isotopic information as to the source of the radiation. In order to calculate
dose, consideration must also be given to duration of exposure in addition to instrument readings.
Instrument is unidirectional. The window of the pancake or tube probe is the only detecting surface.
2. Although the instrument will detect α, β and γ. The meter will not differentiate between the three
types of ionizing radiation. Simple field techniques can help differentiate (see reverse side).
3. Instrument does not detect neutron, microwave, radio frequency, laser, infrared or ultraviolet
radiation.
4. Instrument may be sensitive or inoperable in radio, microwave, electrostatic, and magnetic fields.

Response
Range:

0 - 2,000 mR/hr: Used to describe gamma radiation
0 - 8,000 cpm: Used to describe alpha and beta radiation.

Alarm
Level:

None.

Product
Safety:

Not intrinsically safe.

Battery:

Two alkaline “D” Batteries or Ni-Cd rechargeable batteries.
June 18, 2009
US EPA Quick Start Guide

QUICK OPERATIONS GUIDE
Prior to
Starting:

1.

Check calibration date.

Start-up

1.

Turn the unit on by turning the range selector knob to the lowest scale (0.1).

2.

Press the BAT button. The display pointer should move to the area of the display marked BAT
TEST. If it does not, replace the batteries before proceeding.

2.

Move the AUD switch to on and verify the detector noise.

3.

Press the RES (reset) button and confirm that the meter pointer returns to the zero position.

4.

Record background readings before proceeding to the survey area.

1.

If a source of known intensity is available an instrument performance or confidence check may
be performed. Expose the instrument to the known source and observe the reading.

2.

Move the F/S switch to verify the reading in both fast and slow response modes.

3.

Compare the readings with the known source intensity a reading of + or - 20% of the known
source intensity is acceptable.

Optional
Performance
Check:

Zero:

Press the RES (reset) button and confirm that the meter pointer returns to the zero position.

Calibration:

Not applicable, yearly manufacturer calibration.

Turn Off:

1.

Turn the range selector knob to the off position.

2.

The batteries should never be stored in the instrument for more than 30 days.
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TechTIPs

The latest from Photovac
Volume 3, Number 1

MicroFID Flame Ionization Detector
Operational Reference Guide
INTRODUCTION
This TechTIP is a reference guide for day to day operation of the MicroFID Flame Ionization
Detector. For more detailed information, please refer to the MicroFID User’s Manual.
The MicroFID measures the concentration of airborne Volatile Organic Compounds (VOCs),
displays and then records these concentrations. It does not distinguish between individual
compounds. The reading represents the total concentration of all VOCs present in the sample.
MicroFID will display concentration in PPM.
TUTOR KEY
To assist you in learning the key functions, MicroFID has a built-in tutorial session that displays
a two-line description of the function of each key.
 Press the TUTOR key to begin a tutorial session
 Press the EXIT key after any other key to end the session
Note: While in the tutorial session, key presses have no effect on the MicroFID’s operation.
CALIBRATION
Note: The hydrogen cylinder must be filled prior to operation.
Before beginning calibration, ensure you have a reliable source of zero air and calibration gas.
 Select the CAL key.
 Select the desired Cal Memory. The MicroFID has 10 Cal Memories and can be calibrated
with 10 different span gases or response factors if desired. Only one Cal Memory can be
used at a time. Each Cal Memory stores a different Response Factor, zero, sensitivity, and
alarm level.
 Key in desired Response Factor and hit Enter.
Note: If the Response Factor is not listed in the User’s Manual or if you are measuring complex
VOC mixtures, a value of 1.00.

CALIBRATION Continued









Select Low Range or High Range and hit Enter. Use Low Range if you are sampling
concentrations between 0.5 and 2000 ppm (methane equivalents). Use High Range if you are
sampling concentrations between 10 and 50,000 ppm (methane equivalents).
Connect the supply of zero air. If you are using room air press Enter. If you are using a gas
zero air, connect the gas bag adapter to the inlet. Open the gas bag and press Enter. Zero
calibration will take 60-90 seconds.
MicroFID prompts for the span gas concentration. Enter the known span gas concentration
and then connect the span gas.
Press Enter and MicroFID sets its span.
After 60-90 seconds, calibration is complete.
Press the Alarm key and enter the alarm level for the selected Cal Memory.

For further information contact your area representative or Photovac:

Photovac, Inc.
176 Second Avenue
Waltham, MA 02451
Phone: 781-290-0777
Fax: 781-290-4884
www.photovac.com

DataRAM PDR
GENERAL INFORMATION
Equipment Name:

Personal Data-Logging Real-Time Aerosol Monitor (DataRAM)

Model:

PDR-1000

Manufacturer:

Thermo Fisher Scientific, Inc.

Manufacturer
Contact:

Telephone: 888 643 4968
866 282 0430
E-mail:
lori.gorski@thermofisher.com

SPECIFICATIONS
Uses:

To measure the concentration of airborne particulate matter.

Limitations:

Passive instrument, no air pump is installed. May not detect when particulate concentration is
very low.

Response Range:

0.001 mg/m3 - 400 mg/m3

Alarm Level:

User set instant alarm level and STEL.

Product Safety:

Intrinsically safe.

Battery:

Can use a 9 volt alkaline battery for 12 hours, or a rechargeable battery for 48 hours.

Calibration Gas:

Calibration is performed by the manufacturer.
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QUICK OPERATIONS GUIDE
1.

Press ON key. The screen will display “start zero: enter: go to run: next”

2.

Press NEXT key to start a run without zeroing (instrument should be zeroed before each use).

3.

Press ENTER. The instrument is in real-time monitoring mode. Concentrations must be
manually recorded or recorded via data-logging. An “*” is displayed beside the concentration
indicating data-logging.

1.

In a clean environment, place the instrument inside a Z-pouch. Close the zipper.

2.

Connect a rubber hand-pump to the inlet (with filter) of Z-pouch and start to pump in air into
the Z-pouch.

3.

When Z-pouch begins to bulge slightly, press ON key.

4.

Press ENTER to begin zeroing while continuing to pump.

5.

When “CALIBRATION: OK” is displayed, zeroing is complete.

6.

Press NEXT to start a run or to turn off.

Calibration:

1.

Calibration performed by manufacturer.

Turn Off:

1.

Press EXIT, then ENTER, then OFF.

Turn On:

Zero:
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Ludlum 2241-2 (A/B/G)
GENERAL INFORMATION
Equipment Name:

Ludlum Digital Survey Meter

Model:

Model 2241-2 Digital Survey Meter

Manufacturer:

Ludlum Measurements, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

501 Oak Street, Sweetwater, Texas 79556

800-622-0828 (toll-free); 325-235-5494 (office); 325-235-4672 (FAX)
ludlum@ludlums.com
http://www.ludlums.com
NOTE: Guides are to be used by trained personnel
only and DO NOT replace the manufacturer’s
operations or technical manuals. These guides were
developed by field personnel for utilization by EPA
and their contractors and are helpful in quick startup and operations. Various limitations have been
identified through the experience of the development
group. Different makes, models, and updates to this
equipment may change the limitations. It is
recommended that calibration, maintenance, and use
be recorded in a logbook. Additional product
information may be found in the accompanying
Equipment Operating Guides.

SPECIFICATIONS
Uses:

The Ludlum Model 2241-2 survey meter monitors radiation with either Zinc Sulphide scintillation
(Model 43-90) or a pancake detector (Model 44-9). The ZnS scintillation only measures alpha radiation,
The pancake probe measures alpha, beta, and gamma radiation.

Limitations:

1. Instrument provides no isotopic information as to the source of the radiation. In order to calculate
dose, consideration must also be given to duration of dose in addition to instrument readings. Instrument
is unidirectional. The surface of the pancake probe is the only detecting surface.
2. Although the instrument will detect α, β and γ, the meter will not differentiate between the three types
of ionizing radiation. Simple field techniques can help differentiate (see reverse side).
3. Instrument does not detect neutron, microwave, radio frequency, laser, infrared, or ultraviolet
radiation.
4. Instrument may be sensitive or inoperable in radio, microwave, electrostatic, or magnetic fields.

Response Range:

Auto ranging from 0.0 microR/hr - 9999 R/hr; 0.000 microSv/hr - 9999 Sv/hr; 0 cpm - 999k cpm; or 0
cps - 100k cps

Alarm Level:

Programmable visual and audible ALERT and ALARM points for both RATEMETER and
SCALER modes.

Product Safety:

Not intrinsically safe.

Battery:

Two alkaline “D” Cell batteries or Ni-Cad rechargeable batteries. Battery life is 200 hours. Unit will
display low battery warning when battery is below approximately 10%.

Calibration:

Annual manufacturer calibration, check calibration date on a tag or sticker.
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Ludlum 2241-2 (A/B/G)
QUICK START GUIDE
1.

Visually inspect unit, check source (CS-137 located on side of unit), connection cords, probes,
and batteries. Inspect the probes and make sure the protective cover(s) are present. If the
alpha probe cover is missing, visually check the mylar screen for damage. If damaged, do not
use. Check connection cord for damage. Replace if crushed or damaged. Check calibration
date. If unit’s calibration is out of date, not present, or unknown, do not use unit.

2.

Insert batteries into unit. Using the connection cable, attach the appropriate probe to the unit.
Select the detection switch on the unit to the appropriate probe designation (Alpha or
Beta/Gamma). Do not turn unit on unless a probe is attached and selected. Select the probe by
switching the DET switch to either Det 1 or Det 2, depending on probe used.

1.

Turn the unit on by turning the range selector knob from the off position to the ratemeter
position. Upon start-up the unit will display the unit’s information and attachments. The unit
will note the battery condition and operating capabilities. With the switch in the “ratemeter”
position and once the start-up is complete the unit will begin counting.

2.

Push and release the “reset” switch to return the unit to zero and begin counting again.

3.

Move the AUD switch to on and verify the detector noise. Place the “F/S” switch in the “F”
position for fast counting. Place in the “S” position for slow counting.

4.

Check the detection capabilities by holding the probe near the provided check source. Move
the dial from “ratemeter” to “scale” to verify both methods are operating. Zero the scale meter
by pressing the black button on the handle. The scale should return to zero. Rotate the dial to
“ratemeter” and press “reset”. Unit is now functional and ready to record readings.

5.

Prior to entry into the suspected radiation area, collect and record background readings

1.

If a source of known intensity is available an instrument performance or confidence check may
be performed. Expose the instrument to the known source and observe the readings using the
ratemeter position and the scaler position. Note and record the results.

2.

Move the F/S switch to verify the reading in both fast and slow response modes.

3.

Compare the readings with the known source intensity a reading of + or - 20% of the known
source intensity is acceptable.

Zero:

1.

Press the RES (reset) button and confirm that the meter returns to the zero position. In the
scale mode, press and release the black button on the handle.

Calibration:

1.

Yearly manufacturer calibration. Prior to use the user should verify the calibration and service
sheets are present and/or readily available. The user should not use the unit if the calibration is
out of date, not available, or is unknown.

Turn Off:

1.

Turn the range selector knob to the off position. Disconnect the probe and connection cable.
Replace the protective cover on the probe and store properly.

2.

Never store the batteries in the unit when not in use.

Prior to
Starting:

Start-up:

Optional
Performance
Check:
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AP2Ce Chemical Warfare Agent Detector
GENERAL INFORMATION
Equipment Name:

Chemical Warfare Agent Detector

Model:

AP2Ce

Manufacturer:

Proengin Inc. & Arrow-Tech, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

954-760-9990
eric.damiens@proengin.com
http://www.proengin.com

H2 GAS CYLINDER RECEIVER

BUZZER CONTACTS
AP2Ce

BUZZER
SAMPLING
NOZZLES

BATTERY DRAWER

SAMPLING SCRAPERS

S4PE
BATTERY

TEST SCRAPERS

H2 GAS CYLINDER
AP2Ce
BATTERY
PACK

NOTE: Guides are to be used by trained personnel only. DO
NOT replace the manufacturer’s operations or technical
manuals. These guides were developed by field personnel for
utilization by EPA and their contractors and are helpful in
quick start-up and operations. Various limitations have been
identified through the experience of the development group.
Different makes, models, and updates to this equipment may
change the limitations. It is recommended that calibration,
maintenance, and use be recorded in a logbook. Additional
product information may be found in the accompanying
Equipment Operating Guides.

S4PE

SPECIFICATIONS
Uses:

The AP2Ce is used to test for the presence of hazardous concentrations of nerve and mustard agents
in liquid and vapor forms. It is designed for use in explosive atmospheres.

Limitations:

Only detects HD (sulfurated) blister agents, and GA, GB, and VX (phosphated) nerve agents.
May give false response in an enclosed space such as a maintenance shop or engine test bay;
downwind from, or in, dense smoke and fumes. Some of the vapors that may give a false response
are: wintergreen, peppermints, menthol cigarettes, cough lozenges, and smoke. The AP2Ce will not
detect nitrogen mustard, Lewisite, or irritants. The AP2Ce has not been tested against industrial or
household chemicals found in the civilian environment. The instrument will not work properly above
10,000 feet in elevation or in Oxygen levels below 19%. The AP2Ce will operate between -10°C and
55°C. The AP2Ce requires the use of proprietary batteries and proprietary hydrogen cells. The
batteries and hydrogen cells will have to be shipped by air as dangerous goods.

Detection Limits:

Vapors, Aerosols and Droplets:
All G agents (nerve) - 1.5 ppb (3 seconds)
HD (blister) - 60 ppb (5 seconds)
VX (nerve) - 3 ug/cm² (6 seconds)

Alarm Level:

Buzzer can be attached which will alarm at first visual signal (first red indicator light).

Product Safety:

Model AP2Ce is not intrinsically safe. Instrument contains a hydrogen storage device. DO NOT
SHIP THIS INSTRUMENT WITHOUT PROPER SHIPPING PAPERS (UN=1049 “Hydrogen
compressed”).

Battery:

The AP2Ce uses a 7.3V lithium battery pack that slides into a battery drawer. The battery pack
contains two LSH20, liquid cathode, lithium thionyl chloride batteries. A battery will last for 24
hours at 20°C and 11 hours at 0°C. The batteries can be stored up to 3 years.

Detector Gas:

Hydrogen gas cylinder provides ~12 hours of operation. A yellow warning light illuminates prior to
depletion.

QSG AP2Ce v1.1.doc

AP2Ce Chemical Warfare Agent Detector
QUICK START SHEET
1.

Extract the battery slide unit from the body of the AP2C. Insert a battery block in the slide unit
and push until it latches.

2.

Insert a hydrogen cartridge in the handle of the device lining up on of the two marks on the
cartridge in front of the “OFF” index placed on the body of the AP2C. Push the storage device
into handle until it latches.

1.

Turn the tip of the hydrogen cartridge until the white mark is opposite the “ON” index. Display
lights should all flash on upon insertion of cylinder.

2.

A blinking yellow “WAIT” light indicates initialization of the instrument. During initialization,
the unit is automatically pre-heated, the hydrogen circuit is purged, and the flame is ignited.

3.

When first starting up allow the following warm up times:
- 2 minutes maximum for temperature > 10°C
- About 5 minutes for temperature > 0°C < 10°C
- About 20 minutes for temperatures < 0°C

4.

The green “READY” lights up when the unit is ready for use.

5.

When first starting up allow the following warm up times:
- 2 minutes maximum for temperature > 10°C
- About 5 minutes for temperature > 0°C < 10°C
- About 20 minutes for temperatures < 0°C

6.

When the AP2C is operational, green “READY” light flashing, insert and hold the nose of the
S4PE in the sampling pipe of the AP2C (keep the S4PE perpendicular to the AP2C).

7.

Apply continuous pressure (about 15 to 20 sec.) To the push-button of the S4PE to control the
heating of the “TEST” scraper. The red light of the S4PE comes on.

8.

The lights (G, V-HD, V) of the display unit should come on. From detection, stop pressure to
the push-button of the S4PE to avoid the AP2C saturation.

Zero:

1.

N/A.

Calibration:

1.

Field Calibration: AP2Ce must be checked with a confidence test before each use.

Turn Off:

1.

Environment must be clean with no alarms. If the unit is alarming, wait for it to clear.

2.

Uncouple the sampling pipe from the front of the AP2C.

3.

Turn the hydrogen cartridge to the left and line up the white mark opposite the “OFF” index
(green “READY” light and display window lights go out).

4.

Decontaminate if necessary. Extract the hydrogen cartridge. Stow the cartridge in the case.

5.

Extract the battery slide unit from the body of the AP2C. Remove the battery block from the
slide unit and place it in its housing in the case.

6.

Latch the empty battery slide unit in the body of the AP2C.

Prior to
Starting:

Start-up:
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APD 2000
GENERAL INFORMATION
Equipment Name:

APD 2000

Model:

APD 2000

Manufacturer:

Smiths Detection

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

888-473-6747
support.danbury@smithsdetection.com
http://www.smithsdetection.com
NOTE: Guides are to be used by trained personnel only. DO NOT
replace the manufacturer’s operations or technical manuals. These
guides were developed by field personnel for utilization by EPA and
their contractors and are helpful in quick start-up and operations.
Various limitations have been identified through the experience of the
development group. Different makes, models, and updates to this
equipment may change the limitations. It is recommended that
calibration, maintenance, and use be recorded in a logbook.
Additional product information may be found in the accompanying
Equipment Operating Guides.

SPECIFICATIONS
Uses:

Automatically detects and identifies chemical warfare agents [nerve (GA, GB, GD, VX) and
blister (HD, HN, Lewisite (L)] or irritants (pepper spray and mace) present in the atmosphere .

Limitations:

Detector may become saturated when exposed to high concentrations of chemical agents or
interferences. Poor detection of irritants. Susceptible to interferences / false positive readings
with perfume, wintergreen oil, some deodorants, cleaning compounds, smoke and fumes. Unit
temporarily disengages monitoring during “Auto Cal” and “Clear” functions. Requires
periodic leak testing of radioactive source. Extensive decontamination is necessary. Operating
temperatures of -22°F to 126°F.

Response Range:

VX - 4 ppb (30 seconds)
G (nerve) - 15 ppb (30 seconds)
H (blister) - 300 ppb (15 seconds)
L - 200 ppb (15 seconds)
Detection time is 10sec. at higher concentrations.

Alarm Level:

See above detection level section.

Product Safety:

Not intrinsically safe. Instrument contains a 10 millicurie Nickel 63 radioactive source.
DO NOT SHIP THIS INSTRUMENT WITHOUT PROPER SHIPPING PAPERS AND
A COPY OF THE MOST RECENT WIPE TEST.

Battery:

Six alkaline or rechargeable “C” batteries. Under normal conditions the batteries will last up
to 7 hours. In cold weather the batteries may only last up to 1 hour.

Calibration Gas:

N/A. Instrument is self-calibrating, can be checked with a confidence test.

Gamma and x-ray - 50 KeV to 6 MeV
Dose H (p10) - 0.1 mrem to 1,000 mrem
Dose rate: - 1 mrem/hr to 100 rem/hr
Response: < 5 seconds
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APD 2000
QUICK START GUIDE
1.

Install 6 “C” batteries into the “handle” of the instrument.

2.

Unscrew black protective cap from “barrel” of instrument and store it on battery cap retainer
located on the bottom of the handle. DO NOT touch the APD 2000 nozzle or the filtered
nozzle standoff.

3.

Remove filtered nozzle standoff package from transit case. Peel covering from package until
one filter is exposed.

4.

Press nozzle into exposed filter by using the filter cap holder (DO NOT TOUCH FILTER
CAPS WITH YOUR HANDS).

5.

Lay clear plastic covering back in place over the foam filter cap holder (to protect filter caps).

1.

Press and hold POWER button until APD 2000 appears on the display.

2.

Wait for APD 2000 to complete SELF TEST and STNDBY (approximately 3 minutes).

3.

When display shows READY CW, press MODE key 2 times or until READY TEST appears
on the display.

4.

Press H end of confidence sample to nozzle for no longer than 1 second. Make sure to press
hard enough to open plunger at end of confidence samples.

5.

Verify that horn sounds and display shows ALARM TEST and SIM H.

6.

When display returns to READY TEST, repeat steps 4 and 5 using G end of confidence
samples.

7.

Press MODE key 2 times or until READY CW appears on the display. The APD 2000 is now
ready to operate.

Zero:

1.

N/A.

Calibration:

1.

Not applicable. Instrument is self-calibrating.

Turn Off:

1.

Make sure environment is clean and APD2000 is not alarming. If unit is alarming, indicated
by ALARM on the display, wait for it to clear.

2.

Press and hold POWER to turn off (POWER DOWN).

3.

Remove filter cap from barrel and replace back into foam filter cap holder (DO NOT TOUCH
CAP WITH YOUR HANDS).

4.

Replace black protective cap back onto barrel tip.

5.

Remove and store batteries.

Prior to
Starting:

Turn On:
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Multi Gas Monitor (Area RAE)
GENERAL INFORMATION
Equipment Name

Multi Gas Monitor (AreaRAE)

Model:

PGM50-5P

Manufacturer

RAE Systems, Inc.

Manufacturer
Contact

Telephone
877-723-2878/ 408-752-0723
Fax
408-852-0724
Website
www.RAEsystems.com
680 West Maude Avenue, #1 Sunnyvale, CA 94086
NOTE: Guides are to be used by trained personnel only and DO
NOT replace the manufacturer’s operations or technical
manuals. These guides were developed by field personnel for
utilization by EPA and their contractors and are helpful in quick
start-up and operations. Various limitations have been identified
through the experience of the development group. Different
makes, models, and updates to this equipment may change the
limitations. It is recommended that calibration, maintenance,
and use be recorded in a logbook. Additional product
information may be found in the accompanying EOG.

SPECIFICATIONS
Uses:

To detect CO, H2S, VOCs, O2, and combustible gas (LEL).

Limitations:

VOCs as a lump sum. Concentration readings may not mean much if compounds are
unknown. PID Lamps 10.6 eV (Installed) and 11.7 eV (Spare)

Response Range:

See Next Page.

Alarm Level:

See Next Page.

Product Safety:

Intrinsically safe.

Battery:

Rechargeable battery. Fully charged in 12 hours. Run Time 36 hours on full charge.

Calibration Gas:

Four-gas calibration: a 58-liter, 500 psig cylinder, containing CO: 50 ppm; H2S: 25 ppm; LEL
(methane): 50%; O2: 19%; and balance N2. VOC calibration: a 58-liter, 500 psig cylinder,
containing 100 ppm isobutylene and balance air. Purchase from manufacturer or distributor.
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Multi Gas Monitor (Area RAE)
QUICK OPERATIONS GUIDE
Operation &
Calibration:

1.
2.

ER Truck
and Repeater
Computer
Operation
and Data
Logging:

1.

Guidelines for the Calibration and Operation of the individual AreaRAE units can be
found in the Quick Start Guide for the MultiRAE.
Units should be Fresh Air Calibrated before deployment. Place pre-filter on inlet
port, turn units on, when units are ready hold down the MODE and N/- buttons
together until Enter Password= 0000 appears on the screen. Hold down the MODE
button until Calibrate Monitor? appears on the screen. Press the Y/+ twice. After the
calibration is done press the MODE button until the normal screen appears.
Attach the Antenna to the RAELink2 Host found in the truck, then attach the RS-232
cable to the serial port on the ER Computer or any computer with the ProRAE Remote
Software loaded on it (If your computer doesn’t have a Serial Port use the USB
converter located in the Host carrying case). Hold down the ON button located on the
Host unit until the light is solid green.

2.

Turn on the AreaRAE’s and make sure that each unit’s antenna is connected and that
the LED light for Radio broadcasting is lit. Then take the AreaRAE Kit 1 of 2 and
plug the extension cord(located inside case) into a power supply to the exterior adapter.

3.

Open and turn on the computer. Remove the antenna from the case and place on top of
vehicle or highest point available. Once the computer starts up the operating software
will be displayed at full screen. If it is not displayed open the shortcut on the desktop
(ProRAERemote V1.41).

4.

To begin receiving data from the AreaRAEs press F9. The computer will scan for the
signals from the AreaRAEs and begin downloading information once connected. Once
data is being received from all AreaRAEs, deploy AreaRAEs to appropriate locations
for monitoring.

5.

The panel view (F2) displays the four units with room for a total of 32 units. Set up
(F3) can change various setting (more information is in the Manufacturer’s Manual).
Log View (F4) will display the data logged information from the AreaRAE’s. The data
can be shown in detail and graph form.

6.

RAELink2 Repeater Operation: When the Host and AreaRAE are too far from each
other to communicate the use of the RAELink2 Repeater may be necessary. The
repeater can be found in the truck. To operate attach the antenna to the unit and turn on
by holding down the ON button located on the Repeater until the light turns a solid
green.

7.

Place in a line of sight between the RAELink Host and the AreaRAE to establish a
communication bridge.

Turning
on/off the
Alarms:

1.

Hold down the MODE and N/- buttons together until Enter Password= 0000 appears
on the screen. Hold down the MODE button until Calibrate Monitor? appears on the
screen. Press N/- button until Change Monitor Setup? appears on the screen then press
Y/+ button. Press N/- until Change Light and Buzzer Mode? appears, press Y/+
button. Press N/- button to scroll through the options (Both On, Both Off and Light
Only). Press Y/+ button to select option. Press MODE button until the default screen
appears.

Switching

1.

First make sure that the AreaRAE Unit is off and unplugged. Then open the case using

QSG AreaRAE v1.1

Multi Gas Monitor (Area RAE)
the allen wrench and remove the four hex screws (2 on top and 2 on bottom). Be
careful not to pull the electrical cords from the connections when opening the case.

Sensors:

Turn Off:

2.

Next remove the 3 screws from the silver metallic plate and remove the plate gently to
avoid pulling the tubing from the inlet and outlet.

3.

Once the cover is off and the sensors are exposed, remove the unnecessary sensor and
replace with the desired sensor. Make sure that the black line on the sensor label is
lined up with the white marker on the sensor. Replace the plate and screws then the
case and the hex screws.

4.

Once turned on the AreaRAE will recognize the sensors installed and configured.
However the sensors will still need calibration.

1.

Press and hold MODE key until the AreaRAE is OFF. Shutdown Computer.

ALARM LEVEL AND RESPONSE RANGE
LOW ALARM

HIGH ALARM

RESPONSE RANGE

O2

19.5%

23.5%

0 - 30% (volume)

LEL

10%

20%

0 - 100%

CO

35 ppm

200 ppm

0 - 500 ppm

H2S

10 ppm

20 ppm

0 - 100 ppm

CH4

10% (%LEL)

20% (% LEL)

1 - 2,000 ppm
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Dräger Civil Defense Simultest (CDS) Kit
GENERAL INFORMATION
Equipment Name:

Civil Defense Simultest

Model:

CDS Kit

Manufacturer:

Dräger Safety, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

800 615 5503
prodinfo@draeger.net
http://www.draeger.com
NOTE: Guides are to be used by trained personnel only and
DO NOT replace the manufacturer’s operations or technical
manuals. These guides were developed by field personnel for
utilization by EPA and their contractors and are helpful in
quick start-up and operations. Various limitations have been
identified through the experience of the development group.
Different makes, models, and updates to this equipment may
change the limitations. It is recommended that calibration,
maintenance, and use be recorded in a logbook. Additional
product information may be found in the accompanying
Equipment Operating Guides.

SPECIFICATIONS
Uses:

Designed to provide a rapid identification of a chemical agent using specially designed and
calibrated detector tube sets. The CDS kit includes both the CDS-1 and CDS-V kits which are
designed to detect up to five different chemical agents simultaneously in only five minutes. With
this kit, a total of eight different chemical agents can be detected. Primary users of the kit would
include First Responders, the Fire Service, Emergency Responders, Response Teams, such as
HAZMAT, and Federal Agencies.

Limitations:

Limited to agents that the detector tubes are specific to. Limited by sensitivity of detection tubes.
A negative response with the tube does not mean there are no other harmful agents present.

Tube Sensitivity:

Each detector tube has a sensitivity specific to one chemical. The tubes range from a sensitivity of
0.025 ppm for nerve agents to 1 mg/m3 for S-Mustard. See specific tube for details.

Alarm Level:

This test kit does not have any alarms. If positive results, EVACUATE IMMEDIATELY.

Product Safety:

Be wary of shards of glass from broken tips.

Battery:

N/A

Calibration:

No calibration is necessary.

Additional
Operational
Information:

All five tubes of one set (I or V) are tested simultaneously.
Flush the pump with fresh air after each use to clear out any remaining vapors.
Be sure to compress the pump the number of times specified in the tube directions.
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QUICK START GUIDE
1.

Perform leak test on bellow pump.

2.

Reset pump counter to zero.

1.

Scrape the ceramic edge of the Simultest Set Opener at the tip of the tubes multiple times to score the
glass.

2.

Push opener completely over rubber block with ceramic cutter up and apply pressure down until all
tube tips break off.

3.

Insert the tube set into the adapter (flow arrow pointing in). Then break the tips on the other side of
the tubes.

4.

Use the special adapter to connect the hose to the manifold containing the tubes. Snap fit the hose to
the bellow pump.

5.

Grip the pump with one hand, thumb on top, fingers along the bottom. Compress the pump until it
will no longer collapse. The counter will advance. Release pressure on the pump.

6.

Compress the pump 50 times, according to instructions. Pumping action should take approximately
2.5 minutes per set of five tubes.

7.

Color Change in tube indicates the presence of agent. Use laminated instruction card to decipher
results.

8.

Repeat for second set of tubes. It does not matter which set is used first.

Zero:

1.

Reset the counter on the pump to zero by pressing reset button.

Turn Off:

1.

No power required.

Prior to
Starting:
Start-up
Assembly:

Agent

Drager Tube

Sensitivity

Hydrocyanic Acid

Hydrocyanic acid

Phosgene

Phosgene

0.2 ppm

Lewisite

Organic Arsenic Compounds & Arsine

3 mg/m3 (organic arsenic)
0.1 ppm (Arsine)

N - Mustard

Organic Based Nitrogen Compounds

1 mg/m3

S- Mustard

Thioether

1 mg/m3

Agent

Drager Tube

Sensitivity

Nerve Agents

Phosphoric Acid Esters

0.025 ppm

Phosgene

Phosgene

0.2 ppm

Cyanogen Chloride

Cyanogen Chloride

0.25 ppm

Chlorine

Chlorine

0.2 ppm

S-Mustard

Thioether

1 mg/m3

1 ppm
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Dräger Civil Defense Simultest (I)
GENERAL INFORMATION
Equipment Name:

Civil Defense Simultest

Model:

CDS I

Manufacturer:

Dräger Safety, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

800 615 5503
prodinfo@draeger.net
http://www.draeger.com
NOTE: Guides are to be used by trained personnel only and
DO NOT replace the manufacturer’s operations or technical
manuals. These guides were developed by field personnel for
utilization by EPA and their contractors and are helpful in
quick start-up and operations. Various limitations have been
identified through the experience of the development group.
Different makes, models, and updates to this equipment may
change the limitations. It is recommended that calibration,
maintenance, and use be recorded in a logbook. Additional
product information may be found in the accompanying
Equipment Operating Guides.

SPECIFICATIONS
Uses:

The CDS Kit is composed five specially designed and calibrated detector tubes. Each tube detects
a different chemical agent. The set allows for a very rapid determination of agents.

Limitations:

Limited to 5 specific agents. Limited by sensitivity of detection tubes.
No response from tubes does not mean there are no harmful agents present.

Tube Sensitivity:

Agent:
Hydrocyanic Acid
Phosgene
Lewisite
N-Mustard
S-Mustard

Tube
Hydrocyanic Acid
Phosgene
Org. Arsenic
& Arsine
Org. Basic N Comp.
Thioether

Sensitivity:
1 ppm
0.2 ppm
3 mg/m3
0.1 ppm (arsine)
1 mg/m3
1 mg/m3

Alarm Level:

This test kit does not have any alarms. If positive results, EVACUATE IMMEDIATELY.

Product Safety:

Be wary of shards of glass from broken tips.

Battery:

N/A.

Calibration

No calibration is necessary.

Additional
Operational
Information

All five tubes of the set are tested simultaneously.
Flush the pump with fresh air after each use to clear out any remaining vapors.
Be sure to compress the pump the number of times specified in the tube directions.
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Dräger Civil Defense Simultest (I)
QUICK START SHEET
1.

Perform leak test on bellow pump.

2.

Reset pump counter to zero.

1.

Scrape the ceramic edge of the Simultest Set Opener at the tip of the tubes multiple times to score the
glass.

2.

Push opener completely over rubber block with ceramic cutter up and apply pressure down until all
tube tips break off.

3.

Insert the tube set into the adapter (flow arrow pointing in). Then break the tips on the other side of
the tubes.

4.

Use the special adapter to connect the hose to the manifold containing the tubes. Snap fit the hose to
the bellow pump.

5.

Grip the pump with one hand, thumb on top, and remaining fingers along the bottom. Compress the
pump until it will no longer collapse. The counter will advance. Release pressure on the pump.

6.

Compress the pump 50 times, according to instructions. Pumping action should take approximately
2.5 minutes per set of five tubes.

7.

Color change in tube indicates presence of agent. Use laminated instruction card to decipher results.

Zero:

1.

Reset the counter on the pump to zero by pressing reset button.

Turn Off:

1.

No power required.

Prior to
Starting:
Start-up
Assembly:
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Dräger Civil Defense Simultest (V)
GENERAL INFORMATION
Equipment Name:

Civil Defense Simultest

Model:

CDS V

Manufacturer:

Dräger Safety, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

800-615-5503
prodinfo@draeger.net
http://www.draeger.com
NOTE: Guides are to be used by trained personnel only and
DO NOT replace the manufacturer’s operations or technical
manuals. These guides were developed by field personnel for
utilization by EPA and their contractors and are helpful in
quick start-up and operations. Various limitations have been
identified through the experience of the development group.
Different makes, models, and updates to this equipment may
change the limitations. It is recommended that calibration,
maintenance, and use be recorded in a logbook. Additional
product information may be found in the accompanying
Equipment Operating Guides.

\

SPECIFICATIONS
Uses:

The CDS Kit is composed five specially designed and calibrated detector tubes. Each tube detects
a different chemical agent. The set allows for a very rapid determination of agents.

Limitations:

Limited to 5 specific agents. Limited by sensitivity of detection tubes. No response from tubes
does not mean there are no harmful agents present.

Tube Sensitivity:

Agent:
Nerve Agents
Phosgene
Cyanogen Chloride
Chlorine
S-Mustard

Alarm Level:

This test kit does not have any alarms. If positive results, EVACUATE IMMEDIATELY.

Product Safety:

Be wary of shards of glass from broken tips.

Battery:

System does not require any batteries.

Calibration

No calibration is necessary.

Additional
Operational
Information

All five tubes of the set are tested simultaneously.
Flush the pump with fresh air after each use to clear out any remaining vapors.
Be sure to compress the pump the number of times specified in the tube directions.

Tube
Phosphoric Acid Esters
Phosgene
Cyanogen Chloride
Chlorine
Thioether

Sensitivity:
0.025 ppm
0.2 ppm
0.25 ppm
0.2 ppm
1 mg/m3
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Dräger Civil Defense Simultest (V)
QUICK START GUIDE
1.

Perform leak test on bellow pump.

2.

Reset pump counter to zero.

1.

Scrape the ceramic edge of the Simultest Set Opener at the tip of the tubes multiple times to score the
glass.

2.

Push opener completely over rubber block with ceramic cutter up and apply pressure down until all
tube tips break off.

3.

Insert the tube set into the adapter (flow arrow pointing in). Then break the tips on the other side of the
tubes.

4.

Use the special adapter to connect the hose to the manifold containing the tubes. Snap fit the hose to
the bellow pump.

5.

Grip the pump with one hand, thumb on top, and remaining fingers along the bottom. Compress the
pump until it will no longer collapse. The counter will advance. Release pressure on the pump.

6.

Compress the pump 50 times, according to instructions. Pumping action should take approximately
2.5 minutes per set of five tubes.

7.

Color change in tube indicates presence of agent. Use laminated instruction card to decipher results.

Zero:

1.

Reset the counter on the pump to zero by pressing reset button.

Turn Off:

1.

No power required.

Prior to
Starting:
Start-up
Assembly
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MIE DataRAM 4, Model DR-4000
GENERAL INFORMATION
Equipment Name:

DataRAM 4

Model:

DR-4000

Manufacturer:

Thermo MIE Corporation

National
Manufacturer
Contact:

Telephone:
E-mail:

866-282-0430
www.thermo.com

NOTE: Guides are to be used by trained personnel only
and DO NOT replace the manufacturer’s operations or
technical manuals. These guides were developed by
field personnel for utilization by EPA and their
contractors and are helpful in quick start-up and
operations. Various limitations have been identified
through the experience of the development group.
Different makes, models, and updates to this equipment
may change the limitations. It is recommended that
calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found
in the accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

The MIE DataRAM 4 measures the concentration of airborne particulate matter (aerolized liquid
or solid), as well as mean particle size, air temperature and humidity, providing direct and
continuous readout as well as electronic recording of the information.

Limitations:

High humidity may cause elevated readings. Annual factory cleaning and calibration required.
Routinely change dust filters. Not designed to sample highly corrosive aerosols or solvent
fumes. The DataRAM4 must be protected from all forms of precipitation, and may fail under
extreme temps. Never operate without one of its internal filters in place. Due to the relatively
low flow rate, the unit may not be applicable for fence line monitoring of cleanups involving low
concentrations of contaminants in soil.

Response Range:

It covers a wide measurement range: from 0.001 mg/m3 (0.1 Φg/m3) to 400 mg/m3, a 4 millionfold span, corresponding to very clean air up to extremely high particle levels.

Alarm Level:

The alarm function can be enabled/disabled and the alarm level (trigger threshold) can be
selected by the user through the DataRAM 4 keyboard. While the alarm is on, it can be disabled
momentarily by pressing any key on the DataRAM 4.

Product Safety:

Not intrinsically safe.

Battery:

Internal battery: rechargeable sealed lead-acid gel-cell type, 7.2 Ah, 6V, 20-hour run time
between charges (typical). Requires approximately 12 hours to recharge.
AC line: universal voltage charger/power supply, 100-250 V, 50 - 60 HZ.
Note: To enable operation with either its internal battery or with the charger/power supply, the
3-position power selector switch must be placed in its upward “INT. BATT.” position.

Calibration:

Before initiating a measurement run it is advisable to perform the automatic zeroing and internal
check out sequences, to ensure optimal operation. See Start-Up for the procedure. The DR-4000
is factory calibrated in accordance with National Institute of Standards and Testing (NIST)
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MIE DataRAM 4, Model DR-4000
gravimetric standard protocols for particulate levels in air. The zeroing of the instrument will be
the determination of whether factory cleaning/servicing is necessary. A reading of
BACKGROUND HIGH following the zeroing of the instrument is indicative that the internal
optics need cleaning. This can be performed using the special tool that consists of a cut-off
cotton swab inserted into a plastic sleeve and held by a right-angle Allen wrench using denatured
alcohol.
Do not operate with pump cap covering inlet.
Do not operate without internal filter in place.
May be equipped with separator to monitor for PM-10 or 2.5 size particles only.
Unit may also be set up using the computer utility and a serial cable.

Additional
Information:

QUICK OPERATIONS GUIDE
Start Up:

1.

Make sure that the rear panel power switch is in the upward “INT. BATT.” position. Remove
the sampling inlet protective cap by pulling up on the knurled metal outer piece and lifting it off.
Place the sampling inlet protective cap on the inlet storage post located on the bottom left corner
of the rear panel of the instrument. Install inlet tubing, omni-directional sampling inlet, and PM
10 or 2.5 separators if needed. Make sure internal HEPA filter is installed.

2.

Press and hold “ON/OFF” key until product information appears on screen, the “MAIN
MENU” screen will follow shortly.

3.

ZERO/INITIALIZE OPERATION
From the MAIN MENU select “ZERO/INITIALIZE” by moving the “▲▼”cursor to that line.
Press the “ENTER” key. The pump starts up and ZEROING/INITIALIZING will be completed
in 299 seconds. Return to the MAIN MENU screen by pressing the “EXIT” key, otherwise see
manual for trouble shooting, it this process does not work.

4.

SELECTING LOGGING PARAMETERS
-Key “NEXT” from the “MAIN MENU” and the “EDIT MENU” is displayed. The flashing
cursor appears on the “LOGGING PARAMETERS” line. Key “ENTER” and press the “+ or
–” key to toggle between DISABLED and ENABLED, select desired data logging function.
-Key the cursor and select the LOG PERIOD (adjust to desire, 1 minute would be 00:01:00).
Use the “◄or►” cursor to move between significant digits and the “+ or –” key to increase or
decrease the values.
-Key the cursor to reach the TAG line (Run #), adjust to desire, which is usually “01”
-Key cursor to reach the AUTO START line (for most field applications these should be noted
but not modified), AUTO START normally set to “DISABLED”.
-Now return to the MAIN MENU screen by keying the “EXIT” and then the “NEXT” key.

5.

SELECTING SET-UP PARAMETERS
-From the EDIT MENU key the cursor and select the “SETUP PARAMETERS” key and
press the “ENTER” key. Make changes per your requirement, and press the “NEXT” key.
-At the second Setup Screen the relative humidity RH CORRECT should remain “DISABL”
when relative humidity is less than 50%. If relative humidity is greater than 50% or operated
during a wet weather period, the RH CORRECT should be in the “ENABLE” mode. The
TEMPERATURE UNITS: C and the FLOW RATE: 2.00 LPM remain as the default.
Key “NEXT” twice to get screen to set the time and date, make any necessary changes.

6.

-Key “NEXT” again for the next set up screen to display. In this screen site-specific Alarm and
Action Levels can be set or modified. Refer to Instructional Manual for explanation of all
unfamiliar fields. To exit “SETUP PARAMETERS” press “Exit” key, and to return to
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MIE DataRAM 4, Model DR-4000
“MAIN MENU” press the “NEXT” key.

Shut Down:

7.

START RUN
From the MAIN MENU Initiate sampling by selecting “START RUN” and pressing the
“ENTER” key. At the end of sampling period terminate the run by keying “EXIT”. Confirm
the run termination by keying “ENTER”. The DataRAM 4 performs a purging operation for
about 1 minute after terminating a run.

8.

VIEWING DATA ON SCREEN
To access stored data select the “VIEW/ TRANSFER DATA” line on the MAIN MENU, and
press the “ENTER” key. Select “VIEW LOGGED DATA” and press the “ENTER” key.
Press the “NEXT” key to view more data.
After reviewing the appropriate data, key “EXIT” key twice to return to the “MAIN MENU”.

9.

TRANSFERING DATA TO A PC
-Attach the RS-232 cord to the rear of the DataRAM DR-4000 and the other end to the
communications port (COMPORT) on your computer. DataRam 4 software should also be
running.
-From the software window click the “Data Text” tab and then click the “Get new data” icon,
located in the top left hand corner, (right below the “Main” tab).
-To download data to a PC select the “VIEW/ TRANSFER DATA” line on the MAIN MENU,
and press the “ENTER” key. Select “TRANSFER TEXT FILE” and press the “ENTER”.
Software should communicate with DataRam and download logged data.
- Following the downloading of data, you can use the various options on the accompanying
software to create tables, graphs, etc. to present the data. After completing the successful
download of data press the “EXIT” key to return to the “MAIN MENU”.

10.

DELETING LOGGED DATA
-To delete logged data select the “VIEW/ TRANSFER DATA” line on the MAIN MENU, and
press the “ENTER” key. Select “DELETE LOGGED DATA” and press the “ENTER” key.
Press the “NEXT” key to view more data. You have the option to DELETE TAG DATA or
DELETE ALL DATA. Use the “▲▼” to select appropriate option, and press the “ENTER”
key and following instructions on the screen.
-Press the “EXIT” key to return to the MAIN MENU.

11.

If deploying repeatedly at the same locations at the same site, follow steps 2, 3, and 7 and deploy
appropriately labeled instruments.

1.

Note: Record the data on the screen in the logbook including concentration, TWA, and Run
Time. This data is not again readily available.

2.

To Power Off the DR-4000, press and hold the “On/Off” key for 2 seconds, follow instructions
on the screen.
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Dräger Chip Measuring System (CMS)
GENERAL INFORMATION
Equipment Name:

Chip Measuring System

Model:

6405050

Manufacturer:

Dräger Safety, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

800-615-5503
prodinfo@draeger.net
http://www.draeger.com
NOTE: Guides are to be used by trained personnel only
and DO NOT replace the manufacturer’s operations or
technical manuals. These guides were developed by field
personnel for utilization by EPA and their contractors and
are helpful in quick start-up and operations. Various
limitations have been identified through the experience of
the development group. Different makes, models, and
updates to this equipment may change the limitations. It is
recommended that calibration, maintenance, and use be
recorded in a logbook. Additional product information
may be found in the accompanying Equipment Operating
Guide.

SPECIFICATIONS
Uses:
Limitations:

Quantitatively measure hazardous gases and vapors.

1.
2.
3.
4.

Limited shelf life for all chips.
Chips are subject to feed jamming.
Smaller subset of chips is available for CMS.
See manufacturer’s technical specifications in each case of chips (cross interferences,
quantitation, and etc.).
5. Limited to the chemicals that the chips are specific to.
6. One chemical is measured at a time. The chemical has to be known. Interference from
other compounds may affect accuracy.

Response Range:

Various depending on individual chemicals.

Product Safety:

Intrinsically safe.

Battery:

Four alkaline AA batteries are required for operation. One set of batteries allows the analyzer to
run for 450 minutes and perform more than 100 measurements.. Only use Varta LR64006;
Energizer alkaline LR6 E91; or Panasonic AA, LR6 AM3 AA MN 1500 alkaline/foil (PMBC).

Calibration:

No calibration is required.

QSG DraegerCMS v1.1.doc

1. One chip consists of 10 measurements capillaries filled with a substance-specific reagent
system.
2. A printed bar code on the chip contains information about gas type, measuring range and time
required for completing the analysis.
3. When ordering new chips, request chips with a 2-year shelf life.
4. The analyzer is able to perform 10 tests on one chip for the same chemical.
5. The internal data recorder stores up to fifty measurements with the time, date, contaminant,
concentration, and sequential order of the measurement.

Additional
Operational
Information:

QUICK START GUIDE
Prior to
Starting:

1.

Select the appropriate chip for the gas or vapor to be analyzed. Each chip detects only one
chemical. The measuring range and expiration date should be checked. On the chip, if the
orange pin for a measurement channel is depressed, that channel has been used.

Turn On:

1.

Slide the blue switch to POSITION 1. The instrument will perform a self-test. If only one
battery symbol is displayed, batteries must be changed before further measurements.

2.

When “LOAD CHIP” message appears, insert the chip with arrow pointing toward the analyzer
and barcode up, into the bottom port by pressing chip in upward direction lifting the blue gate.
Slide chip evenly and completely into the chip inlet.

3.

Gas to be measured and concentration range will be shown on the screen.

4.

Following the prompt, slide the switch to POSITION 2 to check the chip. The number of
available measurement channels is indicated on the right of the screen.

5.

When “CHIP OK” is displayed, slide the switch to POSITION 3 to start measurement.

6.

The analyzer displays “MEASURING”, and bars begin to fill in the space between “>” and “<”.

7.

Once measurement is complete, the concentration will be displayed on the screen.

8.

For the next measurement, slide the switch to POSITION 0, eject the chip, and reload again.

Zero:

1.

Not applicable.

Calibration:

1.

No calibration is required.

Turn Off:

1.

Slide the switch to POSITION 0, the chip will be ejected.
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HAZCAT Chemical Identification System
GENERAL INFORMATION
Equipment Name:

HAZCAT Chemical Identification System

Model:

KT 1009

Manufacturer:

HAZTECH Systems, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

800-543-5487
sales@hazcat.com
http://www.hazcat.com
NOTE: Guides are to be used by trained personnel only and DO
NOT replace the manufacturer’s operations or technical manuals.
These guides were developed by field personnel for utilization
by EPA and their contractors and are helpful in quick start-up
and operations. Various limitations have been identified through
the experience of the development group. Different makes,
models, and updates to this equipment may change the
limitations. It is recommended that calibration, maintenance, and
use be recorded in a logbook. Additional product information
may be found in the accompanying Equipment Operating
Guides.

SPECIFICATIONS
Uses:

The Chemical Identification System can be used to identify hazardous characteristics of unknown
materials. By following the HAZCAT CHARTS, an unknown material can be segregated by Hazard
Class and possibly identified.

Limitations:

This system is used for qualitative testing only. Mixtures and wastes are often quite varied in their
composition, and it’s likely that the HAZCAT charts will not provide adequate results. Although by
following the charts, field screening can identify major hazards / properties of the materials. Kits vary
in their contents / reference manual, based on the date of manufacture / publication. Specialized training
or expertise is required to fully utilize the kit’s capabilities.

Accuracy:

Chemical / Chemical Family Identification Mode. If the material appears to be fairly pure, then it is
possible for you to determine its identity by appropriately using the chart and your test results.
Field Screening Mode. If the material is a mixture of compounds, it is likely that identifying its hazard
class by field screening will provide you with more useful and safe results.

General Safety:

PRIOR TO CONDUCTING SCREENING TESTS, OBSERVE CONTAINERS FOR SIGNS OF
LEAKAGE, BULGING, DEGASSING OR IDENTIFICATION. Perform Peroxide tests on any leaked
product around lids or bungs, if positive DO NOT OPEN.
Some of the HazCat reagents are flammable, corrosive and/or need to be kept from an open flame.
Follow the directions on the bottle for each individual reagent and take the necessary precautions.

Product Safety:

The kit utilizes reagent grade chemicals including acids, bases, oxidizers and other hazardous materials.
Wear proper PPE, follow directions and refer to MSDS’s.

Manual:

The manual describes the specific tests to be conducted including positive and negative results. Make
sure you are using the appropriate manual for the respective kit.

Additional
Operational
Information:

Many tests require judgments to be made before proceeding to the next step.
If you are unable to make a clear judgment, try multiple paths and choose the best endpoints. Once you
have arrived at an endpoint in your analysis compare the properties of the material to a complete set of
properties listed in a chemical reference book (NIOSH, Merck, Hawley’s, etc).
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HAZCAT Chemical Identification System
QUICK START GUIDE
The following field screening tests can be performed on each sample in order to identify the
major hazards of the material.
Each test must be done in a precise order-DO NOT deviate from the steps unless the manual
directs you too.
Note:
The following field screening tests are BASIC SCREENING TESTS ONLY! For more
complete and/or comprehensive testing refer to the HAZCAT Chemical Identification
System User’s Manual, and follow the steps laid out in the manual itself.

Field Screening
to determine if
unknown is a
solid or a liquid:

Radiological
Screening Test:

1.

Note: This test is for point source detection only.
-Check batteries, replace if necessary.
-Click the power switch to audio.
-Set the sensitivity to x1 (establish the natural background radiation count by observing the
counts per minute).
-Place the monitor near the closed container. If the sample has a higher then background
radiation count consult an expert and/or refer to your organization’s radiation procedures.
-Place a small amount of the unknown substance on a watch glass.
-The substance can not touch the RadCat Monitor.
-Hold the monitor ¼ to ½ inch away from the substance and observe the count. If the count
is off scale switch to x10-x100 as needed.
Observations:
-If there is no change from the natural background-sample is negative for radiation.
-If the sample is showing greater then normal background levels-consult a radiological
expert regarding further tests and/or refer to organization’s radiation procedures.
-If the sample is showing greater then 300 cpm (counts per minute)-probable gamma source,
EVACUATE!

Evaporation
Test:

2.

An important safety screening/observation test, do not skip!
Quickly evaporating liquids can be dangerous because of potential fire and inhalation
hazards.
Interferences: Results depend on wind, temperature, and humidity. Liquids evaporate more
rapidly on dry, warm days. This test should be performed in an area out of the wind and
away from direct sunlight.
1) Add the unknown liquid to a watch glass to form a pool the size of a dime.
2) Observations:
a) Evaporates quickly; no residue:
Volatile substance indicated. A fire and/or inhalation hazard is present.
b) Evaporates quickly; leaves a residue:
Mixture indicated.
I: Liquid residue: Liquid mixed with oil, solvent or water indicated.
II: Waxy residue: Organic solid dissolved in an organic liquid indicated.
III: Fine crystals or powders: Inorganic salt in liquid indicated.
If testing the liquid does not reveal its identity, continue testing this substance as a solid
unknown. Refer to HazCat Chemical Identification User’s Manual to continue with testing.
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HAZCAT Chemical Identification System
Oxidizers/Acid
tests:

3.

The oxidizer/acid test is designed to screen out strong oxidizers and water-reactive
compounds before placing them into a test tube.
The Acid Test is done simultaneously with the Oxidizer Test to enhance the results.
-Remove the swab and test substance from their respective packaging.
-Add one to two drops of Acid Test to the Oxidizer Test Paper.
-Touch the Oxidizer Test Paper to the sample.
Observations:
-Paper turns black immediately then turns white-positive. Refer to HazCat Chemical
Identification User’s Manual to continue testing.
-Paper turns blue/black, purple or black-positive. Refer to HazCat Chemical Identification
User’s Manual to continue testing.
-Melts paper to black strings-negative. Refer to HazCat Chemical Identification User’s
Manual to continue testing.
-Slight discolorization or very slow reaction-negative. Move on to the water
solubility/reactivity test.
-No color change-negative. Move on to the water solubility/reactivity rest.
Add several drops of Acid Test directly to unknown substance, note the reaction.
Observations:
-Burns or smokes-positive. Confirm with water reactivity test.
-Fumes vigorously-positive. Confirm with water reactivity test.
-Effervesces with odors-positive. Confirm with water reactivity test.
-Effervesces-positive. Confirm with water reactivity test.
-No reaction-negative. Continue to water reactivity test.
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HAZCAT Chemical Identification System
Water Solubility
/Reactivity:

4.

Water Reactivity Test:
All water reactive compounds are acid reactive. Many acid reactive compounds are not water
reactive. Establishing that something is indeed water reactive is important.
Warning: Water-reactive materials are dangerous. Consult applicable regulations
prior to transport or storage.
Liquid:Add the unknown to the watch glass to form a pool the size of a dime.
Solid: Add ½ of a pea-size amount of the unknown to the watch glass.
-Wet an oxidizer test strip with 2 or 3 drops of water solubility test (distilled water).
-Touch the wetted oxidizer test strip to the unknown on the watch glass.
-If the unknown does not react add several drops of water solubility test directly to the
unknown on the watch glass.
-If the unknown reacts to the water observe the reaction.
If the unknown does not react to the water, the unknown is acid reactive only. Go to the
water solubility test (instructions noted below).
Solid Observations:
-Explodes-alkali metal with an oxidized coating indicated. A stong white crust may be noted
over the water-reactive metal.
-Bursts into flame-alkali metal or hydride indicated.
-Strong effervescence-do ignition of off-gas test (refer to user’s manual on how to perform
this test).
-Boils water-alkali hydroxides or oxides indicated.
-Becomes hot-inconclusive. Do a pH test.
-Becomes cold-nitrates or thiosulfate indicated.
Liquid Observations:
-Hesitates, reacts with copious fumes-thionyl chloride, boron trichloride, phosphorous
trichloride, and dimethyl sulfate are possible. The reaction is slow at first but becomes
progressively more vigorous.
-Destroys the strip-concentrated sulfuric acid indicated.
-Boils-sulfuric acid indicated.
Water Solubility Test:
The Water Solubility Test is the most important test specifically for organic liquids.
Liquid: Add ½ inch of water solubility test (distilled water) to a test tube and mark the water
level with an indelible (water-proof) marker. Then add ½ inch of the unknown and shake the
test tube gently. If the unknown seems to be acting oddly (e.g., forming a skin), shake a little
harder. Carefully feel the test tube for any temperature change.
Solid: Add a pea-size amount of the unknown to a test tube containing ½ inch of water
solubility test. Allow time for an unknown to dissolve or otherwise react. Carefully feel the
test tube for any temperature change.
Observations:
-Unknown floats-any liquid that floats is organic.
Unknown dissolves-indicates water; a soluble inorganic or organic compound in water; or a
polar functional group.
-Unknown sinks-re-do the test as follows: add ½ inch of the unknown to a new test tube and
mark the level with an indelible marker. Add ½ inch of water solubility test to the unknown.
If the unknown level is below the line, it has partially dissolved.
-Water level changed: indicates that the unknown is either a polar compound with
approximately four carbons in the skeleton or a mixture of a polar and nonpolar compound.
Go to Organic Analysis (located in the HazCat Chemical Identification Manual).
-Water level did not change: The pH should be neutral.
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HAZCAT Chemical Identification System
Water Solubility
Test Continued..:

4.

If it is not, the unknown has partially dissolved into the water indicating a polar functional
group, in which case you must go to Organic Analysis to continue testing.
-Reacts violently-to arrive at this point means you did the Oxidizer test incorrectly. Re-do
the water reactivity portion of the oxidizer test.
-Any other reaction-do the pH test.

pH Test:

5.

The pH test is a screening test for corrosivity. A corrosive material is defined by DOT as a
liquid or solid that causes visible destruction to, or irreversible alterations in, human tissue at
the site of contact; or, in the case of leakage from its packaging, a liquid that causes severe
corrosion to steel or aluminum. pH is the more common way of expressing corrosivity with
ph of > 12.5 or < 2 being of particular concern.
Interferences: Because pH strips can change color during storage, it is a good idea to set up
a blank for this test. Add ½ inch of water solubility test to a test tube and dip a pH strip in the
water solubility test as a standard. Refer to the blank while testing the unknown solution.
The colors that appear on the blank should be considered neutral; results in the pH 5-10
range should be adjusted accordingly. Readings for strong acids (0-2) and bases (12-14) will
not be affected. Expect accuracy of +/- 2 units near the neutral portion of the pH scale.
-Liquid: Add ¼ inch of the unknown to a test tube containing ½ inch of water solubility test.
-Solid: Add a pea-size amount of the unknown to ½ inch of water solubility test or use the
water solubility test solution if it is available.
-Dip the pH test strip into the unknown solution.
-Allow a few seconds for the colors to develop then compare with the colors on the box of
pH test strips.
Note: if the unknown is an oxidizer, the colors on the test strip will fade quickly as they are
bleached by the oxidizer.
Observations:
-pH of 2 or less-the unknown is an acid corrosive according to the US EPA. Go to Acids
Chart.
-pH near 11-if the unknown is organic, nitrogen is indicated.
-pH of 12-may indicate cyanide, arsenic, strychnine, or amines (Follow up with more
comprehensive testing).
-pH of 12.5 or higher-the unknown is a basic corrosive according to the US EPA.
-pH of 13 or higher-if inorganic, indicates sodium, potassium, calcium, lithium, or cesium
hydroxide. To identify the cation, go to Metal Analysis Test One. If organic, may indicate
guanine, guanidine, or piperidine.
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HAZCAT Chemical Identification System
Explosives Test:

6.

Provides an approximation of the flash point.
If it is a liquid:
-Using a pipette, add the unknown to a watch glass to fom a pool the size of a dime.
If it is a solid:
-Using a spatula, add ¼ of a pea-size amount to the watch glass.
-Heat the explosive test tool tip until it glows red.
-Roll tip into unknown, observe reactions.
-Place explosive tool tip (sample is on tip) into torch flame, observe reaction.
Observations:
-flashes, detonates, or ignites violently-positive. Stop testing and follow agency protocol.
-burns with or without flame-negative. Stop, go to HazCat Chemical Identification User’s
Manual to continue testing.
-burns with sparks-negative. Stop, go to HazCat Chemical Identification User’s Manual to
continue testing.
-smokes-negative. Stop, go to HazCat Chemical Identification User’s Manual to continue
testing.
-no reaction-negative. Continue to HazCat Chemical Identification User’s Manual to
continue testing.
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Jerome Mercury Vapor Analyzer (MVA)
GENERAL INFORMATION
Equipment Name:

Jerome Mercury Vapor Analyzer

Model:

Model 431-X

Manufacturer:

Arizona Instrument Corporation

Manufacturer
Contact:

Telephone:
E-mail:
Website:

800-528-7411
support@azic.com
http://www.azic.com
NOTE: Guides are to be used by trained personnel only and DO
NOT replace the manufacturer’s operations or technical manuals.
These guides were developed by field personnel for utilization by
EPA and their contractors and are helpful in quick start-up and
operations. Various limitations have been identified through the
experience of the development group. Different makes, models, and
updates to this equipment may change the limitations. It is
recommended that calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found in the
accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

Provides real-time measurements (µg/m³ level) of mercury vapor in the air.

Limitations:

1. Can easily saturate the detector, requiring a regeneration procedure to be performed;
2. Can not achieve the detection limit recommended for residential occupancy (0.0003 mg/m3);
3. Interferences from high humidity, temperature variation, household cleaners, and smoke;
4. Old/oxidized mercury used for functional test may give inaccurate results.

Response
Range:

0.003 mg/m3 - 0.999 mg/m3

Alarm Level:

If sensor completely saturated; display shows “8.8.8” , sensor regeneration is required to operate.

Product Safety:

Caution: designed for vapor use only; DO not allow probe or intake to contact liquids, dust or
foreign material. Not intrinsically safe.

Battery:

To prevent a memory effect from occurring in the nickel-cadmium battery, resulting in a decreased
usable battery capacity, follow these steps:
1) At least once a month, wait until LO BAT appears before recharging.
2) Charge the battery as soon as LO BAT appears.
3) Complete battery recharging takes 14 hours.
4) A fully charged battery can operate for a minimum of 6 hours.

Calibration:

Factory calibration required. Perform mercury functional test to check calibration of the
instrument.

Additional
Operational
Information:

Functional test should be performed monthly. Refer to the manual for the test procedure and
acceptable range of readings.

QSG Jerome v1.1.doc

Jerome Mercury Vapor Analyzer (MVA)
QUICK START GUIDE
Start-up

Zero:

Calibration:
(Functional
Test)

1.

Turn unit on by pressing “ON” button and waiting 1 minute for warm up. Display will flash
“.000” when ready. This procedure must be completed at the beginning of sampling, end of
sampling, and if the sensor is saturated.

2.

Press “SAMPLE” to take the reading. Note the saturation bars displayed. If “8.8.8” is present
proceed with the sensor regeneration procedure.

3.

If regeneration is required, wait 10 minutes to zero the unit. Start sensor regeneration by
pressing the “REGEN” button. “HHH” will flash on the screen while sensor regeneration is in
progress. When finished screen will flash “.000” to indicate it is ready for sampling.

4.

Attach inlet probe if point source monitoring is desired. The instrument has two modes:

5.

Sample Mode: Push “SAMPLE” button and take 12 second reading in mg/m3.

6.

Survey Mode: Push and hold “SAMPLE” button and take one 12 second reading followed by
repeated readings every 3 seconds (decreased sample volume effects accuracy by 20%).

1.

NEVER ZERO THE INSTRUMENT UNTIL THE ABOVE “TURN ON” PROCEDURE IS
COMPLETED. NEVER ZERO THE INSTRUMENT BETWEEN SAMPLES. Ideally, wait
for 30 minutes after the “Turn On” procedure is completed. In an emergency situation, you
may zero the instrument immediately following the “Turn On” procedure.

2.

Depress the “Zero” button on the top of the instrument. If the instrument displays a zero, no
additional steps are required.

3.

If the unit displays an “H”, turn the Zero Adjust screw (just below the “On” button) counterclockwise while depressing the “Zero” button until the instrument displays a zero.
If the unit displays an “L”, turn the Zero Adjust screw clockwise while depressing the “Zero”
button until the instrument displays a zero. The Zero Adjust screw may be turned using the
trimmer tool supplied with the unit. A small standard head screw driver may also work.

4.

Instrument is ready for sampling if functional test is not required. Sampling is conducted
simply by depressing the “Sample” button and waiting approximately 12 seconds for a result to
be displayed.

1.

This test does not calibrate the instrument. Calibration should be conducted yearly at the
Arizona Instruments facility. This functional test checks the factory calibration. It is not
required to perform air monitoring but is advised if the unit will be used extensively or is
subjected to high levels of mercury vapor.

2.

The temperature range for the test is 18-22°C (64.4-71.6°F).

3.

Perform the functional test only after the heat regeneration “Turn On” procedure is completed.

4.

To begin, plug the tubing adapter end of the septum assembly into the instrument’s intake and
tighten the intake tube nut. The seal should be tight.

5.

Attach a zero air filter to the opposite end of the septum assembly.

6.

Record the temperature from the thermometer in the mercury thermos.

7.

Draw the 1 cc sample from the mercury thermos with a preset syringe.
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Jerome Mercury Vapor Analyzer (MVA)
Calibration:
(Functional
Test)

8.

Insert the syringe into the septum of the septum assembly already attached to the analyzer.

9.

Press the sample button, wait 2 seconds, when the display flashes, inject the mercury vapor
into the septum assembly by depressing the syringe.

10.

Record the result displayed on the instrument.

11.

Repeat steps 6-10 three more times.

12.

The last three readings should be within 5 percent of each other.

13.

The last three readings should also be within a concentration range based upon the temperature
noted in step 6. The ranges are as follows for the thermos temperature (°C):
Temp.

Range

16
17
18
19
20
21
22
23
24

.091 to .123
.100 to .135
.108 to .146
.118 to .159
.129 to .174
.138 to .187
.151 to .204
.164 to .222
.177 to .240

If the average of the final three readings is within the above range, the instrument is
functioning properly.

Turn Off:

14.

Refer to the Operational Manual if the functional test results are not within the specified range.

1.

Press the “Off” button.
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Ludlum Model 15 Neutron Counter
GENERAL INFORMATION
Equipment Name:

Model 15 Survey Meter

Model:

15

Manufacturer:

Ludlum Measurements, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

501 Oak Street, Sweetwater, Texas 79556

800-622-0828 (toll-free); 325-235-5494 (office); 325-235-4672 (FAX)
ludlum@ludlums.com
http://www.ludlums.com
NOTE: Guides are to be used by trained personnel only and DO
NOT replace the manufacturer’s operations or technical manuals.
These guides were developed by field personnel for utilization by
EPA and their contractors and are helpful in quick start-up and
operations. Various limitations have been identified through the
experience of the development group. Different makes, models,
and updates to this equipment may change the limitations. It is
recommended that calibration, maintenance, and use be recorded
in a logbook. Additional product information may be found in the
accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

To detect α, β, γ, and n radiation.

Limitations:

Cannot monitor for α/β and n radiation simultaneously (detector change required). γ radiation
can be monitored with either detector. To calculate dose, the instrument reading, duration of
exposure, and target must be considered. Instrument reading is NOT equivalent to dose.

Response Range:

0-500,000 Counts/Minute.

Alarm Level:

No alarm. Audible click frequency relative to the rate of incoming pulses when AUD switch
in ON position.

Product Safety:

Not intrinsically safe.

Battery:

Two D-cell alkaline batteries. Typical battery life is 600 hours. Battery condition can be
checked on the meter.

Calibration:

Calibration performed annually by manufacturer. Periodical bump test using a check source
provided by the manufacturer is recommended. Do not use if calibration is out of date,
unknown, or not available.

Shipping
Instructions:

Special shipping requirements may be necessary if check source is attached to instrument. See
dangerous goods shipping manual for further instructions. Call manufacturer for complete
instructions and requirements for shipping unit back to factory. Refer to the appropriate DOT
requirements for shipping and handling of dangerous materials when shipping.
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Ludlum Model 15 Neutron Counter
QUICK START GUIDE
Prior to
Starting:
1

Visually inspect unit and accessories. Check module, wires, probe(s), and other accessories. Do not
attempt to substitute probes from like units. Probes are calibrated to the unit. Changing probes may result
in incorrect readings. Make sure the end cap is on the probe. If missing check the mylar screen for
damage. Do not use if probe and/or unit is damaged.

2

Install two D-cell batteries in accordance with polarity marks on underside of battery box lid. The battery
box is located under the handle on the meter face and is opened by twisting the knob counterclockwise.
Close lid and secure.

3.

Connect the appropriate probe to the module using the connection cable. Position the “B-G/N” toggle to
the appropriate probe used. Connect the desired detector to the meter. Connect the Neutron Detector for
response from γ and n radiation. Connect the G-M (Geiger-Meuller) Detector for response from α, β and γ
radiation.

4

Rotate dial to “BAT” position and check battery status. Needle should move onto the “bat test” bar.
Rotate the dial to the X1000 position and press the “HV” red button and note where on the meter the needle
falls. It should be approximately to the 1 position.

5.

Toggle Response (F/S) Switch to the “F” position. F indicates fast response between trigger events and
meter deflection on the instrument (4 seconds to full-scale); S indicates a slow response between trigger
events and meter deflection (22 seconds to full-scale). S position is used only to get accurate “hot-spot”
measurements. Toggle the AUD to the “ON” position for audible alarm signal.

6.

Toggle Radiation Selector (B-G/N) Switch to desired radiation/detector specific response. G-M Detector
will only give response when switch is in B-G position. Neutron Detector will give γ response in B-G
position and n response in N position.

7.

With the proper detetion probe attached, and away from any known radiological source, obtain and record a
background reading.
G-M Detector (α, β and γ radiation)

Detector
Response
Checks:

1.

Rotate the Range Switch from OFF to X1000. Ensure the Radiation Selector Switch is in the B-G position,
the Audio Switch is in the ON position and the Response Switch is in the F position.

2.

Expose the detector to a radiation check source (α/β/Cs137). Proportional audible clicking should be heard
with the AUD Switch in the ON position. At this range setting meter deflection may not be apparent.

3.

Press the High Voltage (HV) Button. The meter should read approximately 900-1000 volts.

4.

Rotate the Range Switch to the lower scales (X10 or X1) until a meter reading is indicated.

5.

Vary the distance between the check source and the detector while watching the deflection speed of the
meter. Now, toggle Response Switch to the S position while varying the distance to the check source and
note that the meter deflection is slower in this position. Return the F/S Switch to the F position.

6.

Press the Reset (RES) Button in the vicinity of the check source and ensure the meter goes to zero.
Neutron Detector (γ and n radiation)

1.

Rotate the Range Switch from OFF to X1000. Ensure Radiation Selector Switch is in the N position, the
Audio Switch is in the ON position and the Response Switch is in the F position.

2.

Press the High Voltage Button. The meter should read approximately 1500 volts.

3.

Expose detector to a neutron check source (n). Note audible clicking and adjust Range Switch until
deflection registers on the meter.
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4.

Toggle Radiation Selector Switch to B-G position. Expose detector to a gamma check source (Cs137).
Note audible clicking and adjust Range Switch until deflection registers on the meter.

5.

Press the High Voltage Button. The meter should read approximately 900 volts.

Zero:

1.

Do not attempt to zero unit. Zero should only be conducted at the factory using appropriate procedures. .

Turn Off:

1.

Rotate the Range Switch to the OFF position and remove batteries. Batteries should not be stored in unit
when not in use. Disconnect probe and cables. Return unit to its proper storage container.

Calibration:

1.

Calibration performed annually by the manufacturer. Prior to use the user should verify the calibration and
service sheets are present and/or readily available. The user should not use the unit if the calibration is out
of date, not available, or is unknown.
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Lumex TM Mercury Vapor Analyzer (MVA) – Soil Attachment
Soil
Analysis
Start Up
(Matrix):

Soil
Analysis
Calibration:

1.

There is a CD with the attachments and the standards that has the software to run the Lumex,
copy it and install the software, or before field work go to
http://www.ohiolumex.com/fware/index.shtml and download the control software for the
Lumex. Once the file is downloaded, unzip the file, 18 files will unzip, open the setup.exe file
and install the software. The program will be opened later.

2.

Remove the main unit from its hard and soft cases. Then remove the LCD screen unit and attach
the two 15 pin cables to the Lumex and the 9 pin cable to the computer that has the software.

3.

Turn the power switch on the Lumex and ignite the lamp. (See No. 4 on Air Analysis Startup)
Set the optical bridge on the back of the instrument to Position I.

4.

Attach the Pyrolysis oven to the external analytical cell port on the side of the instrument (long
side). Warning the oven connection is fragile. Make sure the output line off the glass/pvc T is
connected to the pump and inline with the zero mercury filter and flow meter.

5.

Attach the flow meter to the stand and check all tubing for kinks or holes. Replace tubing if
necessary. Discoloration or blackened tubing does not affect the results.

6.

Connect the power supply cables to the Pyro oven and the pump and plug them in and turn on
the oven’s power to allow it to heat. Caution Oven will get extremely hot. Allow oven on
attachment and Lumex lamp to warm up for 30 minutes.

7.

Turn on the pump and adjust the flow to be between 2-3 Liters/minute.

1.
Open the Lumex operating software on the computer. On the main menu select
“Complex” and click on it. Two screens will appear; Complex Sample analysis and Table
screen. Press Run on the graph toolbar of the analysis screen. The integration window will pop
up. You will see two lines running on the screen; a Blue and Red line. The Red line is the
analytical signal line with the y axis on the left of the graph. The Blue line is a Photo multiplier
current signal which is reported on the y axis on the right of the graph. The proper value must be
15000 arb. units or higher.
2.

Sterilize and clean the sample boats by inserting them into the oven for 30 seconds and then let
them cool.

3.
Press on the Baseline Check button on the Control toolbar. Wait 10 seconds and
then click the button again to establish the baseline.
4.
Press cursor on the Table window (brings up Complex analysis table). Enter the
test site information in the top blank window. Press on the Description field and double click left
mouse button. The windows with Blank and Standard selection will pop-up. Select Blank and
press on Tab key. Press Start in the Integration window then insert an EMPTY boat in the oven.
5.
Wait approximately 30 seconds then press End and remove the boat. Data will
be entered in the table automatically.
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Lumex TM Mercury Vapor Analyzer (MVA) – Soil Attachment
Soil
Analysis
Calibration:

6.

Double click the description field for entry number 2. Select Standard, and the cursor will be
present after Std___, at this point type in the standard concentration in parts per billion (ppb) or
μg/kg, with the standard that is labeled NIST 2709 1.4 ppm and do a three point calibration
curve. Enter 1400 after Std___1400. Enter 10 mg in the M column and press the tab key. Then
Press the START button on the integration window.

7.

Place the sample boat on the balance and hit the tare button (Use a balance that weighs to 1 mg
or 0.001 g with a draft ring or doors). Weigh out approximately 10 mg of the NIST standard
into the tared sample boat.

8.

Take the sample boat loaded with standard to the Lumex. Press the Start button on the
Integration window. Immediately place the sample boat inside the oven. When the signal
returns to the baseline or about 45 seconds Press the End Button in the Integration Window

9.

Repeat steps 6 through 8 with 20 and 60 mg standard sizes to establish multipoint calibration.
You can do as many “duplicates” as required to increase accuracy and precision.

10.

Click the Table button on the Program toolbar and click the Select button. Click on
Row number 1 then hold down the Shift button and press the down arrow to highlight the Blank
and all the Standards rows. Note: Only Blank and Standard rows must be selected for
calibration.

11.

Soil Sample
Analysis:

1.

2.

On the Calculation toolbar click on the Cal. Graph button. The Graph will appear.
Click the Apply button (The graph can be saved as a bitmap if you press the Save button). Click
Exit and click the Yes button to save the calibration coefficients. After that click on the
Calculation button at the Table toolbar and the calculated concentration values will appear in C,
ng/g column. The concentration reported in the column is in ppb’s or μg/kg units.
Click the table button on the Program toolbar. Click the description field and type in
the sample ID and enter the sample weight in milligrams in the M field.
Click the Graph button on the Table toolbar in the Table-Complex Analysis Screen.
Tare a room temperature boat on a balance. Then put some of the sample into the boat and
record the weight in the M field of Table column in milligrams.

3.
Press the Start button in the Integration window and insert the boat into the oven.
Wait for the signal to return to the baseline or 60 to 90 seconds.
4.
Then press the End button in the Integration window. Click the Select button to
enable you to highlight an entire row, and highlight the row that contains you sample data.
Click the Calculation button on the Table toolbar. The Mercury concentration in parts per
billion or μg/kg will be reported in the C field.
5.

6.

After all samples are analyzed click Report in the Table toolbar when finished to
see a tabulated report of the samples. This report data can be exported into Microsoft Excel by
pressing the Export to Excel button located on the File toolbar.
Before dismantling soil analysis setup allow enough time for oven to cool.
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Lumex Mercury Vapor Analyzer (MVA)
GENERAL INFORMATION
Equipment Name:

Lumex Mercury Analyzer

Model:

Model RA915+

Manufacturer:

Ohio Lumex Company

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

Sm
1
2
3
Sc:
R (%) =

888-876-2611
mail@ohiolumex.com
http://www.ohiolumex.com
NOTE: Guides are to be used by trained personnel
only and DO NOT replace the manufacturer’s
operations or technical manuals. These guides
were developed by field personnel for utilization
by EPA and their contractors and are helpful in
quick start-up and operations. Various limitations
have been identified through the experience of the
development group. Different makes, models, and
updates to this equipment may change the
limitations. It is recommended that calibration,
maintenance, and use be recorded in a logbook.
Additional product information may be found in
the accompanying Equipment Operating Guides.

ng/m³
S: 213
Si: 209
10 *

SPECIFICATIONS
Uses:

Provides portable real-time measurements of mercury vapor in ambient air, natural, and stack
gases. Attachments allow analysis of water and complex matrices.

Limitations:

1. Temperature sensitive; needs time to stabilize.
2. Dusty environments and moisture (high humidity) effect accuracy by absorbing moisture.
3. Fragile: Strong vibrations and shocks in use and transit effect accuracy.
4. Battery lifespan.

Response Range:

In Air: 2 ng/m3

Alarm Level:

Alarm warning in Sm mode indicates mercury readings above present high limit.

Product Safety:

Not Intrinsically Safe.

Battery:

Rechargeable Ni-Ca Battery. Complete battery recharging takes 5 hours, 3.5 hours of operation.
Should remain attached to charger, with unit off, until ready for use. Do not store unit with
discharged battery for more than 3 days to avoid permanent damage.

Calibration:

Performs auto-calibration every time it is turned on.
Factory calibration required if relative standard deviation greater than 25%.
Calibration standard:
Soil: NIST 2709 1.4 ppm
Water: Aldrich Cat No. 40,401-2 100ml of 1002 μg/ml of Hg in 8 -10 wt. % HNO3.

Additional
Operational
Information:

Complete Test Run prior to use. Make sure dust filter is present before operating.

In Water: 0.5 ng/L

In Soil: 0.5 mg/kg
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Lumex Mercury Vapor Analyzer (MVA)
QUICK START SHEET
Start-up:

Sample
Measurement:

1.

Attach hose by inserting and turning clockwise. Turn on unit by pressing the ”Power” button
and wait 15 minute for warm up (display shows Lumex Title Screen).

2.

Press “ENT” until LCD reads “* Main Menu”. Press “Lamp Ignition”, the “*” disappears, let
warm 5 minutes.

3.

Scroll down to Test and press “ENT”.

4.

After warm up, message will appear “Enter the Test Cell”, toggle test cell switch on instrument’s
side between on and off several times and leave in “ON” position

5.

Press ”ENT”, R (%) less than 25% indicates unit ready for use. Press “ESC”, message “remove
Test Cell” will appear, toggle test switch to off. Do NOT leave the test switch on during normal
sample measurement.

6.

Press “ENT” to get back to Main Menu, ready to sample

1.

For air monitoring turn Rotary switch to Position III (on the back of the width of the LUMEX).
Turn Power switch on front end (Red toggle switch)
LCD display will show Lumex Title Screen (LUMEX Ver. 3.0.L 2000)

2.

Attach sampling hose by inserting and turning the connection clockwise. Make sure it is snug.
Also attach the muffler on the outlet port on the same panel as sampling hose.

3.

Press Ent button on top: LCD display will show “*Main Menu” (the * means the lamp is off)

4.

Press “Lamp Ignition” push button (dark red) that is just below & to the left from the Power
switch. The “*” will disappear. Let the lamp warm up for five minutes before collecting data.

5.

Press down arrow key to “On stream”

6.

Press Ent button: Baseline Test occurs for 20 seconds.
Readings then start with update every second in the upper right corner of LCD screen.

7.

Press Ent again: Readings continue every second, but with various summary functions.
Three 10-second averages are displayed after 1: 2: and 3: After 30 seconds, a 30 second
Below “Sc =” the associated Relative Standard Deviation will be displayed after R(%)=

8.

Three different choices are available at this point:
Calculate another 30-second average by pressing Ent again (can be done many times)
Turn off machine: press Esc, and then turn the red Power switch to Off.
Calculate a new baseline (especially if you are trying to measure very subtle effects and
want to be sure of your zero): press Esc, down arrow to “On stream”, then press Ent.

Water Analysis:

1.

See Attachment A for how to use the Lumex to analyze water samples.

Soil Analysis:

1.

See Attachment B for how to use the Lumex to analyze soil or tissue samples

Turn Off:

1.

Press POWER to turn off unit. Wash the probe thoroughly with tap water.
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Lumex TM Mercury Vapor Analyzer (MVA) – Water Attachment
Water
Analysis
Start-Up:

1. There is a CD with the attatchments and the standards that has the software to run the Lumex, copy
it and install the software, or before field work go to http://www.ohiolumex.com/fware/index.shtml
and download the control software for the Lumex. Once the file is downloaded, unzip the file, 18
files will unzip, open the setup.exe file and install the software. The program will be opened later.
2. Remove the main unit from its hard and soft cases. Then remove the LCD screen unit and attach
the two 15 pin cables to the Lumex and the 9 pin cable to the computer that has the software.
3. Turn the power switch on the Lumex and ignite the lamp. (See No. 4 on Air Analysis Startup but
ignore the (*) portion) Set the optical bridge on the back of the instrument to Position II.
4. Preparation of SnCl2 Solution: In a 100 mL flask add 95 mL water, and then add 5 mL
concentrated sulfuric acid (this is the solution that you will put the stannous chloride in).
Mix thoroughly. Remove 20 mL of the prepared solution from volumetric flask then add 10 g of
stannous chloride to volumetric flask. Mix the solution until the crystalline solid dissolves. Add
back the prepared solvent solution that was removed during the previous step up to 100 mL.
Ensure all the stannous chloride is dissolved prior to pouring into the Lumex (or container).
Preparation of Mercury Calibration Standard (1ppb): Using the ~1000 μg/mL Mercury
Standard Solution, add 1uL of standard to 1.0L of distilled water in a 1.0 L volumetric flask. This
will produce a solution with a concentration of 1ppb (1μg/L). 1mg/mL * 10μL = 0.000010 mg/L
5. Open the RP-91 box that contains the pump and the impingers. (Glass tubes) Attach the impingers
to the slip groove in the swivel stand. Place the flow meter onto the swivel stand also. Place the
single path cell into the auxiliary compartment of the Lumex. Place the glass cap into impinger 2
and connect the stem near the top of impinger 1 to the glass cap with tubing. Pinch the two pieces
of tubing at the bottom of the impingers 1 & 2 with the two clamps provided in the case. A
diagram is in the manual for the water attachment. The manual can be found attached to this quick
start, on the CD, or from the Lumex website.
6. Pour approximately 10 ml of the SnCl2 solution made in step 4 into Impinger 1.
7. Connect the power supply to the pump and to an outlet, then start the pump. Adjust the flow to 1
Liter per minute. Wait 5-10 minutes to purge the system before starting calibration.
8.

Open the Lumex operating software on the computer. On the main menu select
the Liquid and click on it. Two screens will appear; the Liquid Sample analysis screen and the
Table screen. Press Run on the graph toolbar of the analysis screen. The integration window will
pop up. You will see two lines running on the screen; a Blue line and Red line. The Red line is
the analytical signal line with the y axis on the left of the graph. The Blue line is a Photo multiplier
current signal which is reported on the y axis on the right of the graph. The proper value must be
15000 arb. units or higher.
9.
Press on the Baseline Check button on the Control toolbar. Wait 10 seconds and
then click the button again to establish the baseline.
Water
Analysis
Calibration:

1.
Click on the Table window (brings up Liquid analysis table). Enter the test site
information in the top blank line. Press on the Description field on line #1 and double click left
mouse button. The windows with Blank and Standard selection will pop-up. Select Blank and
press on Tab key, enter 1 in V, ml column and press Tab Key. Press Start in the Integration
window then inject 1 milliliter of Blank (deionized water) in the first impinger using a pipette.
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Lumex TM Mercury Vapor Analyzer (MVA) – Water Attachment
Water
Analysis
Calibration:

2.

After injecting the blank wait 50-90 seconds then press End in integration
window. Data acquired will be entered in the table automatically.
3. Double click the description field for entry number 2. Select Standard, the cursor will be present
after Std_, at this point type in the standard concentration in parts per billion (ppb) or parts per
trillion (ppt). The concentration is from the standard that was made in the Start Up section do a
three point calibration curve. Use 1 ml of standard solution which is 1000μg of actual mercury.
Enter 1000 after Std_1000. Enter 1 ml in the V, ml column. Then Press the START button on the
integration window.
4. Immediately introduce the standard in Impinger 1. Click the End button in the Integration window
when the signal returns to the baseline (after about 90-120 seconds).
5. Repeat steps 3 & 4 with 2.0 and 3.0 ml standard sizes to establish multipoint calibration. You can
do as many “duplicates” as required to increase accuracy and precision.
6.
Click the Table button on the Program toolbar and click the Select button. Click
Row number 1 then hold down the Shift and press the down arrow (or Ctrl and mouse) to highlight
the Blank and all the Standards rows. Note: Only Blank and Standard rows should be selected for
calibration curve!
7.
On the Calculation toolbar click on the Cal. Graph button. The Graph will appear.
Click the Apply button (The graph can be saved as a bitmap if you press the Save button). Click
Exit and click the Yes button to save the calibration coefficients. After that click on the
Calculation button at the Table toolbar and the calculated concentration values will appear in C,
ng/L column. The concentration reported in the column is in ppb’s or μg/L units.
Water
Sample
Analysis:

1.
For sample analysis click on Pause in Graph Window and then Click in New File button.
The New file will open. Click on Run. When liquid in impinger #1 gets near the neck open the
clamp at the bottom and drain liquid into waste container. Add approximately 10 mL of the fresh
SnCl2 solution.
2. Click on the Table window or click on the Table button on the Program toolbar.
3. Click the Description field, enter the sample ID, then the volume in milliliters in the V, ml field.
4. Press the Start button in the Integration window and introduce the sample into Impinger 1.
5. Wait for the signal returns to the baseline or 60-90 sec. Then press the End button in the
Integration window.
6.

7.

Click the Select button to enable you to highlight an entire row, highlight the row that
contains the data from the sample that was just analyzed, and click on the Calculation button on the
Table toolbar. The mercury concentration in ppb will be reported in the C field.
After all samples are analyzed click Report in the Table toolbar when finished to see a
tabulated report of the samples. This report data can be exported into Microsoft Excel by pressing
the Export to Excel button located on the File toolbar.
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Ludlum Model 12 Ratemeter
GENERAL INFORMATION
Equipment Name:

Ludlum Ratemeter Meter

Model:

Model 12 Count Ratemeter Equipped with Model 44-9 Geiger-Meuller Pancake Probe

Manufacturer:

Ludlum Measurements, Inc

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

501 Oak Street, Sweetwater, Texas 79556

800-622-0828
ludlum@ludlums.com
http://www.ludlums.com
NOTE: Guides are to be used by trained personnel only
and DO NOT replace the manufacturer’s operations or
technical manuals. These guides were developed by
field personnel for utilization by EPA and their
contractors and are helpful in quick start-up and
operations. Various limitations have been identified
through the experience of the development group.
Different makes, models, and updates to this equipment
may change the limitations. It is recommended that
calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found
in the accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

The Ludlum Model 12 Count Ratemeter monitors radiation with proportional, scintillation, or
Geiger-Mueller (G-M) detectors. The instrument shown above (left) is equipped with a Model
44-9 (G-M pancake) probe that will detect alpha, beta and gamma radiation. The instrument can
be used with other Model 43 and Model 44 series detectors for measurement of other radiation
intensities.

Limitations:

1. Instrument provides no isotopic information as to the source of the radiation. In order to
calculate dose, consideration must also be given to duration of exposure in addition to instrument
readings. Instrument is unidirectional. The surface of the pancake probe is the only detecting
surface (instrument reading is not equivalent to dose).
2. Although the instrument will detect α, β and γ, the meter will not differentiate between the
three types of ionizing radiation. Simple field techniques can help differentiate. (See reverse)
3. Instrument does not detect neutron, microwave, RF, laser, infrared, or ultraviolet radiation.
4. Instrument may be sensitive or inoperable in RF, microwave, electrostatic, or magnetic fields.

Response Range:

0 - 500,000 counts per minute (cpm), used to describe alpha and beta radiation.

Alarm Level:

None.

Product Safety:

Not intrinsically safe.

Battery:

Two alkaline “D” Batteries or Ni-Cd rechargeable batteries.

Calibration:

Annual Manufacturer Calibration, check calibration date on a tag or sticker.
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Ludlum Model 12 Ratemeter
QUICK START SHEET
Prior to
Starting:

Start-up:

Optional
Performance
Check:

1.

Check calibration date.

2.

Turn the range selector knob to BAT. The needle should move to the area of the display
marked BAT TEST. If the needle is out of this range replace the batteries.

1.

Turn the unit on by turning the range selector knob to the lowest scale (0.1)

2.

Move the AUD switch to on and verify the detector noise.

3.

Press the RES (reset) button and confirm that the meter pointer returns to the zero position.

4.

Record background readings before proceeding to the survey area.

1.

If a source of known intensity is available an instrument performance or confidence check may
be performed. Expose the instrument to the known source and observe the reading.

2.

Move the F/S switch to verify the reading in both fast and slow response modes.

3.

Compare the readings with the known source intensity a reading of + or - 20% of the known
source intensity is acceptable.

Zero:

Press the RES (reset) button and confirm that the meter pointer returns to the zero position.

Calibration:

Yearly manufacturer calibration only.

Turn Off:

1.

Turn the range selector knob to the off position.

2.

The batteries should never be stored in the instrument for more than 30 days.
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Ludlum Model 19 Gamma Detector
GENERAL INFORMATION
Equipment Name:

Ludlum Gamma Detector

Model:

Model 19

Manufacturer:

Ludlum Measurements, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

501 Oak Street, Sweetwater, Texas 79556

800-622-0828 (toll-free); 325-235-5494 (office); 325-235-4672 (FAX)
ludlum@ludlums.com
http://www.ludlums.com
NOTE: Guides are to be used by trained personnel only and
DO NOT replace the manufacturer’s operations or technical
manuals. These guides were developed by field personnel
for utilization by EPA and their contractors and are helpful
in quick start-up and operations. Various limitations have
been identified through the experience of the development
group. Different makes, models, and updates to this
equipment may change the limitations. It is recommended
that calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found in
the accompanying Equipment Operating Guide.

SPECIFICATIONS
Uses:

A rapid, real-time quantitative measurement of low-level gamma radiation.

Limitations:

1. Instrument will not detect alpha or beta radiation and provides no isotopic information as to the
source of the radiation. To calculate dose consideration must also be given to duration of dose in
addition to instrument readings (instrument reading is not equivalent to dose).
2. Instrument does not detect neutron, microwave, RF, laser, infrared, or ultraviolet radiation.
3. Instrument may be sensitive or inoperable in RF, microwave, electrostatic, or magnetic fields.
4. The instrument detects gamma and x-ray radiation.
5. When exposed to predominantly low-energy gamma radiation, the instrument will over
respond.

Response Range:

0 - 5,000 microrems per hour (microR/hr).

Alarm Level:

None.

Product Safety:

Not intrinsically safe.

Battery:

Two alkaline “D” Cell Batteries or Ni-Cad rechargeable batteries. Batteries should not be stored
in detector when not in use.

Calibration:

Annual Manufacturer Calibration, check calibration date on a tag or sticker. Prior to use the user
should verify the calibration and service sheets are present and/or readily available. The user
should not use the unit if the calibration is out of date, not available, or is unknown.
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Ludlum Model 19 Gamma Detector
QUICK START SHEET
Prior to
Starting:

Start-up:

1.

Visually inspect unit and accessories. Do not use if unit appears damaged. Check calibration
date. Insert two D-cell batteries into the unit. Rotate the dial to the 5000 position and press
the battery button and note the location of the needle. It should be between the “BAT OK”
arrow.

2.

Push the AUD (audio) switch to the “ON” position. Push the “F/S” switch to the “F” position.
F indicates fast response (4 seconds); S indicates slow response (22 seconds).

3.

Push and check the “L” button. The internal meter light should come on.

1.

Turn the unit on by turning the range selector knob to the lowest scale (25).

2.

Press the button marked BAT. The needle should move to the area of the display marked BAT
TEST. If the needle is out of this range replace the batteries.

3.

Press the button marked L to verify that the meter display illuminates.

4.

Move the AUD switch to on and verify the detector noise. Set the meter response switch (F/S)
as desired.

5.

Press the RES (reset) button and confirm that the meter pointer returns to the zero position.

6.

Record background readings before proceeding to the survey area.

7.

Turn the range switch to the highest level (5,000), and then 500, 250, 50, 25, until a response
on the meter is detected. Read red scale when the switch is pointed to a red range, and read
black scale when the switch is pointed to a black range. The measurement is as follows:
At 25 (red), the measurement range is 0 - 25 μR/hour.
At 50 (black), the measurement range is 0 - 50 μR/hour.
At 250 (red), the measurement range is 0 - 250 μR/hour.
At 500 (black), the measurement range is 0 - 500 μR/hour.
At 5,000 (black) the measurement range is 0 - 5,000 μR/hour.

1.

If the gamma source is of a known intensity, a confidence check or instrument performance
may be performed. Expose the instrument to the known source and observe the reading.

2.

Move the F/S switch to verify the reading in both fast and slow response modes.

3.

Compare the readings with the known source intensity a reading of + or - 20% of the known
source intensity is acceptable.

Zero:

1.

Press the RES (reset) button and confirm that the meter pointer returns to the zero position.

Calibration:

1.

Yearly manufacturer calibration. Prior to use the user should verify the calibration and service
sheets are present and/or readily available. The user should not use the unit if the calibration is
out of date, not available, or is unknown.

Turn Off:

1.

Turn the range selector knob to the off position. Remove batteries from the unit. Batteries
should never be stored in the instrument when not in use.

Optional
Performance
Check:
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Ludlum 192 (Gamma MicroR Survey Meter)
GENERAL INFORMATION
Equipment Name:

Model 192 Survey Meter

Model:

192

Manufacturer:

Ludlum Measurements, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

501 Oak Street, Sweetwater, Texas 79556

800-622-0828 (toll-free); 325-235-5494 (office); 325-235-4672 (FAX)
ludlum@ludlums.com
http://www.ludlums.com
NOTE: Guides are to be used by trained personnel only
and DO NOT replace the manufacturer’s operations or
technical manuals. These guides were developed by
field personnel for utilization by EPA and their
contractors and are helpful in quick start-up and
operations. Various limitations have been identified
through the experience of the development group.
Different makes, models, and updates to this equipment
may change the limitations. It is recommended that
calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found
in the accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

To detect low-level ionizing γ (gamma) radiation during area surveys.

Limitations:

1. Instrument detects gamma and x-ray radiation.
2. Instrument does not detect neutron, microwave, radio frequency, laser, infrared, or
ultraviolet radiation.
3. The instrument may be sensitive or become inoperable in radio, microwave, electrostatic, or
magnetic fields. Will not detect α or β radiation through case shielding.
4. When exposed to predominantly low-energy gamma radiation, the instrument will over
respond.
5. The instrument will respond to x-ray machines and pulsed radiation sources, but not
linearly.
6. To calculate dose, the instrument reading, type of radiation, duration of exposure, and target
must be considered.

Response Range:

0 - 5000 μR/hr

Alarm Level:

Alarm level automatically set to 3 x background. Constant tone and illuminated alarm light.
Audible beep frequency relative to the rate of incoming pulses when AUD switch is ON.

Product Safety:

Not intrinsically safe.

Battery:

Unit uses two D-cell alkaline batteries. Under normal use, battery life is approximately 600
hours. Battery condition may be checked using the unit’s meter. Note: Do not store batteries
in the unit when not in use.

Calibration:

Calibration and services are performed annually by manufacturer. Copies of the certification
and service performed should be maintained with the unit. Periodical bump test using a check
source of known activity provided by the manufacturer is recommended before each use.
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Ludlum 192 (Gamma MicroR Survey Meter)
QUICK START GUIDE
1.

Visually inspect the unit for serviceability and condition. Do not use if unit’s case shows signs of being
broken, cracked or damaged without prior approval from the factory. Use of a damaged unit may result in
inaccurate readings and may cause injury to the user and others.

2

Install two D-cell batteries in accordance with polarity marks on underside of battery box lid. The battery
box is located under the handle on the meter face and is opened by twisting the knob counterclockwise and
lifting the compartment door. Close and secure door prior to operation.

3

Toggle Audio (AUD) Switch to the “ON”position. This provides an audiable alarm (notification) when unit
detects levels of radiation exposure above the preset limits. User may cancel the audio alarm function by
placing the toggle switch to the “OFF” position, if necessary.

4.

Toggle Response (F/S) Switch to either the “F” or “S” position. The “F” position indicates fast response
between trigger events and meter deflection on the instrument (4 seconds to full-scale); The “S”position
indicates a slow response between trigger events and meter deflection (22 seconds to full-scale). S position
is used only to get accurate “hot-spot” measurements. User should check with the appropriate agency’s
procedures and policies for switch setting, if applicable.

5

Rotate the Range Switch from the “OFF” position to the “BAT” battery check) position. The meter should
deflect to the “BAT TEST” portion of scale. Batteries are good if the needle falls anywhere within the
arrowed portion of the scale. If not check to make sure the batteries were proper installed and/or replace
batteries with new batteries. Recheck battery status and verify condition.

1.

Make sure you are not in a radiation area or have any radiation sources nearby. Rotate the Range Switch
from “BAT” to “X1000” Verify the Audio Switch is in the “ON” position and the Response Switch is in
the F position (as applicable).

2.

Unit will temporarily alarm as it acquires a “background” setting. Wait for the instrument to establish
background for the purpose of alarm. The instrument will beep and the ALARM lamp will flash every halfsecond during the 8-10 second background period. Once a background level has been obtained the audible
alarm and the flashing light will cease. Should the alarm continue, verify that there are no radiological
sources present and/or move to another location and re-check. Should the alarm continue a third time, verify
with a secondary radiological unit to confirm/deny presence of radiological source. If no radiological source
is noted, the unit should be deadlined and returned for service. Do not use if alarm will not stop.

3.

Rotate the Range Switch from X1000 to X10. Any deflection is due to background sources.

4.

Expose the detector (identified by dimples in the case) to a radiation check source (Cs137). Audible beeps
should be heard with the“AUD” Switch in the “ON” position. These beeps should be accompanied by a
flashing ALARM light and upscale meter deflection.

5.

Vary the distance between the check source and the detector while watching the deflection speed of the
meter. Now, toggle Response Switch to the S position while varying the distance to the check source and
note that the meter deflection is slower in this position. Return the F/S Switch to the F position.

6.

Ensure that once the meter shows deflection beyond the preset alarm threshold the ALARM light
illuminates and the tone alarm is constant. Pressing the RESET Button will silence the alarm and return the
unit’s scale to “zero” and re-set. If the detection unit is still in close proximity of the source and the user has
not changed the dial’s settings, the unit will continue to alarm. Rotate the dial to the next higher detection
level and re-check. Continue checking and moving the dial until the no longer continues to alarm. Note the
dial setting and scale value and the point where the alarm activates. Always begin on the lowest setting
(X1) and work towards X1000

7.

Pressing the RESET Button when the ALARM threshold has not been achieved returns the meter to zero
and starts the 8 second background sequence. This will not effect the readings.

Prior to
Starting:

Detector
Response
Checks:
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Ludlum 192 (Gamma MicroR Survey Meter)
Zero:

1.

Zero of the unit should be done at the factory. Never attempt to zero the scale unless authorized, by the
factory to do so. Changing the zero settings may alter the unit’s readings.

Turn Off:

1.

Rotate the Range Switch to the “OFF” position and remove the batteries. Make sure the unit, if
contaminated, has been cleaned before returning to its storage container or shelf.

Calibration:

1.

Calibration is performed annually by the manufacturer. Prior to use the user should verify the calibration
and service sheets are present and/or readily available. The user should not use the unit if the calibration is
out of date, not available, or is unknown.
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Ludlum Model 3030 (A/B)
GENERAL INFORMATION
Equipment Name:

Model 3030 Alpha-Beta Sample Counter

Model:

3030

Manufacturer:

Ludlum Measurements, Inc.
501 Oak Street
Sweetwater, Texas 79556

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

800-622-0828 (toll-free); 325-235-5494 (office); 325-235-4672 (FAX)
ludlum@ludlums.com
http://www.ludlums.com
NOTE: Guides are to be used by trained
personnel only and DO NOT replace the
manufacturer’s operations or technical manuals.
These guides were developed by field personnel
for utilization by EPA and their contractors and
are helpful in quick start-up and operations.
Various limitations have been identified through
the experience of the development group.
Different makes, models, and updates to this
equipment may change the limit-ations. It is
recommended that calibration, maintenance, and
use be recorded in a logbook. Additional product
information may be found in the accompanying
Equipment Operating Guide.

SPECIFICATIONS
Uses:

To perform simultaneous α and β radiation measurement on air filter, soil and wipe samples.
Advanced sample tracking and analysis methods when used in conjunction with integrated
computer software (see instrument manual for more information).

Limitations:

The instrument can accept a maximum sample size of 2 inches in diameter by 0.4 inch thick.
The instrument does not detect gamma radiation.
A PC interface is necessary in order to access the advanced functions of the instrument.

Response Range:

0 - 999999 Counts per Minute (CPM) or Disintegrations per Minute (DPM) for both α and β.

Alarm Level:

Adjustable alarm levels for both α and β counts. Constant tone and illuminated alarm light for
both α and β. Audible beep frequency relative to the rate of incoming pulses above background
when VOLUME is turned up.

Product Safety:

Not intrinsically safe.

Battery:

AC is primary power. Internal trickle-charged battery with an approximate life of 8 hours.

Calibration:

Calibration performed annually by manufacturer. Prior to use the user should verify the
calibration and service sheets are present and/or readily available. The user should not use the
unit if the calibration is out of date, not available, or is unknown.
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Ludlum Model 3030 (A/B)
QUICK START GUIDE
Prior to
Starting:

Turn On:

Start-up
Performance
Check: Using
Computer
interface

Sample
Counting:

Turn Off:

1.

Visually inspect unit, wires, and accessories. Make sure all accessories are present and serviceable
before attempting to use. If the unit appears to be damaged, do not attempt to use. Damaged unit
may not provide accurate results. Ensure the unit is plugged into a power source or that the batteries
are sufficiently charged.

2.

Plug unit into electrical outlet. Set the COUNT TIME to 1 MINUTE on the Count Time Selector
Knob. Ensure the VOLUME is turned up to an audible level.

3.

Install Ludlum software package on PC. Connect cables to PC. Check the instrument’s battery level.
If the instruments operating parameters have not been set, the red QC LED will illuminate, and an
initial quality control (QC) check must be performed.

1.

Push the power switch to the ON position.

2.

Press and release the QC button. Insert “alpha” source and press the count button. When count is
complete, remove “alpha” source from the tray assembly, replace with “beta” source, close and lock
tray, and press the count button. When count is complete remove the “beta” source from the tray
assembly, close and secure the tray and press count. If the unit is functioning properly the QC LED
will go out. Unit is now ready. If the QC LED remains on, repeat the process and check operating
parameters. The unit CPM or DPM LED will remain green.

1.

Click on “Normal QC” in tab marked “QC Settings” click on “Reload Last Values”.

2.

Enter “Standard Alpha Efficiency”, “Standard Beta Efficiency” from sources, click “Update”.

3.

Enter values for “Allowable QC Efficiency”, click “Update”.

4.

Enter “Alpha Source Size”, “Update”.

5.

Enter “Upper & Lower Background Limits”, “Update”. Disconnect PC from instrument.

6.

Press “QC Check” insert alpha calibration sources, and press “Count”, repeat for beta.

7.

The instrument is now ready for use. Select the count time and statistical accuracy based on field
monitoring with a Model 12. Rotate the sample tray, knob, open and insert sample. Adjust volume.
Press “Count”, results in CPM or DPM.

1.

Insert the sample into the Sample Tray, close the tray and LATCH the Tray Locking Knob.

2.

Press the COUNT Button and wait the required count time. If the red αAL LED illuminates, the
sample has exceeded the alarm threshold for α radiation and if the red βAL LED illuminates, the β
radiation alarm threshold has been exceeded. If the red OL LED illuminates, the sample is too
radioactive and has overloaded the detector. Dilute the sample or reduce the sample volume.

3.

Record the counts shown in the α-ALPHA and β-BETA display windows.

4.

Rotate the Tray Locking Knob to UNLATCHED position and remove the sample. Store sample in
proper storage container until the sample can be properly shipped and/or disposed of.

5.

Decontaminate the tray with a DI moistened KimWipe, throw wipe in a marked “Radioactive Waste”
container. Close the Sample Tray, rotate the Tray Locking Knob to LATCHED and press the
COUNT Button. The unit should register no activity above background levels. If the Sample Tray is
still contaminated, repeat this process until background activity is achieved.

1.

Push the power switch to the OFF position.
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MultiRAE Plus
GENERAL INFORMATION
Equipment Name:

MultiRAE Plus

Model:

PGM-50

Manufacturer:

RAE Systems Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

877-723-2878
tech@raesystems.com
http://www.raesystems.com
NOTE: Guides are to be used by trained personnel only
and DO NOT replace the manufacturer’s operations or
technical manuals. These guides were developed by
field personnel for utilization by EPA and their
contractors and are helpful in quick start-up and
operations. Various limitations have been identified
through the experience of the development group.
Different makes, models, and updates to this equipment
may change the limitations. It is recommended that
calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found
in the accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

Limitations:

Response Range:

The MultiRAE uses both standard gas detection sensors for detection of: O², CO, H²S, VOC and
combustible gas (LEL). The MultiRAE also has an integrated Photo Ionization Detector (PID)
for broad-range toxic gas detection.
1. Gas concentrations exceeding the upper limit of detection of the instrument (refer to
table, manual pages 1-3) will not be properly detected. Any up-scale reading followed
by a declining or erratic reading may indicate a gas concentration beyond the upper scale
limit which may be hazardous.
2. Properly operates in ambient conditions of -4° to 113°F and 0-95% relative humidity
(non-condensing).
3. Instrument not tested in explosive gas / air atmosphere having an oxygen concentration
greater than 21%.
4. The internal and external filters should be inspected and replaced as necessary.
5. Some sensors are cross-sensitive to many chemicals. See attachment 3, RAE TN-114.
Can be found on the Air Sampling CD
6. Not compound specific, PID calibrated to isobutylene. Other compounds have different
response factors.
7. If the ionization potential of a compound is higher than the lamp energy, the compound
will not be detected.
8. PID lamp requires periodic cleaning depending on operating conditions.
9. Detection of chemical warfare agents are un reliable, even if calibrated.
Oxygen: 0-30%; Combustible gas: 0-100% LEL; VOCs: 0-2000 ppm; Carbon Monoxide: 0-500
ppm; Hydrogen Sulfide: 0-100 ppm; Sulfur Dioxide: 0-20 ppm; Nitric Oxide 0-250 ppm;
Nitrogen Dioxide: 0-20 ppm; Chlorine: 0-10 ppm; Hydrogen Cyanide: 0-100 ppm; Ammonia: 050 ppm; Phosphine: 0-5 ppm.
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Alarm Level:

90 dB buzzer and flashing red LED to indicate that preset limits were exceeded.
HIGH: 3 beeps; LOW: 2 beeps; STEL and TWA: 1 beep and flash per second.
Alarm latching with manual override or automatic reset.
Additional diagnostic alarm and display message for low battery and pump stall.

Product Safety:

UL® Classified as Intrinsically Safe for use in Class 1, Division 1, Group A, B, C, & D
Hazardous Locations

Battery:

Rechargeable, nickel-cadmium (NICAD) or Li-ion battery pack, or 4 “AA” alkaline battery
adapter. The factory –supplied rechargeable NICAD battery is designed to last for 10 hours of
normal operation (no backlight, no alarms) under best conditions, Li-ion batteries are expected
to last up to 20 hours. As the battery becomes older, and/or under cold ambient temperatures,
battery capacity will be reduced significantly. NICAD are especially prone to build up a memory
if not discharged deeply. Fresh alkaline batteries will provide approximately 12-14 hours of
operation under ideal conditions.

Calibration and
Maintenance:

Two-point field calibration for zero and span gas.
Four-gas calibration: CO 50 ppm, H²S 25 ppm, LEL (methane) 50%, O² 19%, and balance N².
VOC calibration: isobutylene 100 ppm.

Critical
Operational
Information:

Any rapid up-scale reading followed by a declining or erratic reading may indicate a gas
concentration beyond upper scale limit, which may be hazardous.
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MultiRAE Plus
QUICK START GUIDE
Prior to
Starting:

Start-up:

Calibration:

1.

Check batteries by unplugging the MultiRAE unit from the charger and noting battery level on
the display.

2.

Make sure that the instrument is calibrated.

1.

Press and hold “Mode” key until monitor beeps once, monitor will go through a 90-second
warm-up sequence.

2.

Watch display screen for messages such as, “sensor installed and their warranty expiration”,
“Alarm limits”, “Last calibration date”, “User/Alarm/Datalog modes”.

3.

After 90 sec. warm -up, the MultiRAE goes into monitoring mode, taking real-time readings.

4.

When monitoring, the unit alternately displays the instantaneous gas concentrations and the
sensor names. In a non hazardous environment the sensor readings should be similar to the
following: (TOX1 and TOX2=0, VOC=0, LEL=0 and OXY =20.9). Alarm Limits are set for
High, Low, STEL, and TWA. When an alarm condition occurs, the monitor will provide audible
and visual alarms to alert users of unsafe conditions.

5.

Instruments response time for different gas varies from 15 second to 150 seconds. Allow
sufficient time before recording the reading.

1.

Hold down “Mode” and “N/-” keys simultaneously for 5 sec to get in Programming Mode. If
Multi RAE asks a question “?”, reply “Y/+” or “N/-”. To accept or Escape use “MODE” key.
Repeatedly pushing the “Mode” key will eventually return user to main display.

2.

When display shows “Calibrate Monitor?”, press “Y/+” key

3.

Fresh Air (Zero) Calibration
-“Zero Air” can be from a cylinder, clean ambient air, or ambient air purified through a charcoal
filter. This procedure should “always” be performed prior to any sensor calibration.
-When display shows “Fresh Air Calibration?” press “Y/+” key. When successful, the display
should show a reading of “20.9” for oxygen sensor and “0.0”, or a very small number for all
other sensors.

4.

Multiple Sensor Calibration
-If you are using a multiple gas cylinder at “Multiple Sensor Calibration?” press “Y/+” key. If
all sensors in display window are to be calibrated attach calibration gas cylinder to unit using a
regulator and calibration adaptor, press the “Y/+” key to start calibration process, and follow
instructions on screen. Disconnect regulator from gas cylinder when calibration is complete.
-If only certain sensors in the display are to be calibrated, press the “N/-” key, and use the
“Mode” key to select the sensors and press the “Y/+” or “N/-” key to select or deselect sensor,
an “*” next to the sensor indicates the sensor will be calibrated. Hold down “Mode” key to
save, and when “save?” is displayed, attach calibration gas cylinder to unit using a regulator and
calibration adaptor, press the appropriate “Y/+” or “N/-” key to save the values, and start the
calibration process. Follow instructions on screen. Disconnect regulator from gas cylinder when
calibration is complete.
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Turn Off:

5.

Single Sensor Calibration
Note: if “no gas flow” is detected during calibration, press “Y/+” key to start calibration
process.
If you are using a single gas cylinder at “Single Sensor Calibration?” press “Y/+” key, use
“Mode” key to select desired sensor. Attach calibration gas cylinder to unit using a regulator and
calibration adaptor, press the “Y/+” key and follow instructions on screen. Disconnect regulator
from gas cylinder when calibration is complete.

6.

“Modify Span Value?” allows you to change the concentration of the calibration gas.
“Change LEL/VOC Span Gas?” allows you to change the calibration gas from methane (LEL)
and isobutylene (VOC)

1.

Press the “Mode” key for 5 seconds to power down the instrument

ALARM LEVEL AND RESPONSE RANGE
LOW ALARM

HIGH ALARM

RESPONSE RANGE

O2

19.5%

23.5%

0 - 30% (volume)

LEL

10%

20%

0 - 100%

CO

35 ppm

200 ppm

0 - 500 ppm

H2S

10 ppm

20 ppm

0 - 100 ppm

CH4

10% (%LEL)

20% (% LEL)

1 - 2,000 ppm
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RADeCO High Volume Air Sampler
GENERAL INFORMATION
Equipment Name:

RADeCO High Volume Air Sampler/Air Volume Totalizer

Model:

H-810

Manufacturer:

RADeCO, LLC

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

860-823-1220
techsupport@radeco.com
http://www.radecollc.com
NOTE: Guides are to be used by trained personnel only and DO
NOT replace the manufacturer’s operations or technical manuals.
These guides were developed by field personnel for utilization by
EPA and their contractors and are helpful in quick start-up and
operations. Various limitations have been identified through the
experience of the development group. Different makes, models,
and updates to this equipment may change the limitations. It is
recommended that calibration, maintenance, and use be recorded
in a logbook. Additional product information may be found in
the accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

The Model H-810 sampler is a grab sampler with an air volume totalizer will automatically shut
off the unit when a specified volume of air has been sampled. This microprocessor-based unit is
designed to eliminate the use of rotameters and mechanical time meters. The air volume totalizer
portion of the sampler is composed of an enclosed air turbine that rotates at speeds proportional
to the air flow velocity of the sampled air. The flow rate, total volume, and elapsed time are
displayed on the liquid crystal display (LCD) screen.

Limitations:

Accuracy is limited to ± 5 percent. Requires 110 V AC with backup battery, used for sample data
retrieval in the event of a power loss.

Response Range:

Not Applicable

Alarm Level:

Not Applicable

Product Safety:

A 2000 Watt Inverter Model RAD2KINV is commonly used and is not for use in explosive or
combustible atmospheres .Can not come into contact with foam, liquid (including water) or other
foreign substances, could result in severe electrical shock.

Battery:

9 VDC used for Back-up.

Calibration:

Unit requires re-calibration with Model C-828 Calibration unit each time a different filter media
is used.

Additional
Operational
Information

Handle the instrument with care. Model H-810 sampler with air volume totalizer will
automatically shut off the unit when a specified volume of air has been sampled. The flow rate
total volume, and elapsed time are displayed on the liquid crystal display (LCD) screen.
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RADeCO High Volume Air Sampler
QUICK START SHEET
1.

Plug the instrument into a power source. Calibrate the meter as discussed under “Calibration.”

2.

Install the sample holder with the filter media between outer retaining and mesh filter support grid
and then turn the power switch on.

1.

Press START key

2.

Adjust the flow rate as desired by turning the screw on the side of the sampler (default 1-6 CFM).
The site specific flow rate will be used to calculate the derived air concentration (DAC) for the
site. DAC = concentration of radionuclides in air that if breathed for a work year would result in
an intake corresponding to a dose limit.

3.

Press the “STOP” key and the “CLEAR” key.

4.

Set desired total air volume to sample and press the “START” key. The sampler will run until the
desired total air volume had been sampled.

5.

Once the total air volume is achieved, collect the paper filter sample and prepare it for analysis.

Zero:

1.

N/A.

Calibration:

1.

Install the sample holder assembly containing the sample medium (paper filter) used for sampling
into front of the sampler and connect the sample holder inlet to an air flow calibrator. Depress &
hold “ENTER” and “SET” keys simultaneously, turn the power switch “ON”. Note: The LCD
screen will read: “CALIBRATE FLOW?”; press “1” for yes.

2.

Screen Prompt “UNIT OF MEASURE.” “1” for cubic feet or “0” for liters.

3.

Screen Prompt “ADJUST FLOW-HIGH POINT.” (Example: 3-4-5 cfm, 3=LOW POINT,
4=MIDPOINT, 5=HIGH POINT). Adjust, enter the high flow rate, “ENTER.” for 15 seconds.

4.

LCD screen will read “ADJUST FLOW - MIDPOINT.” Adjust, enter the midpoint flow rate on
keypad, and press “ENTER.” Keep flow constant for 15 seconds.

5.

LCD screen will read “ADJUST FLOW - LOW POINT.”. Adjust, enter the low flow rate on
keypad, and press “ENTER.” Keep flow constant for 15 seconds.

6.

LCD screen will read “VERIFY LINEARITY.” Adjust the flow to various points within the
calibration range and press “ENTER” to accept calibration or “CLEAR” to reject it.

7.

“BAD CALIBRATION,” = inaccurate flow data or the turbine speed sensor requires service.
Screen Prompt “DEFAULT RUN MODE.” mode of operation = “0” for TOTAL VOLUME or
“1” for TOTAL TIME.

8.

Screen Prompt “ENTER TARGET.” Select Liters or cubic feet (TOTAL VOLUME MODE ) or
minutes and seconds (TIME MODE). Note: Normal operation, both volume and time displayed.

9.

Screen Prompt “WARM UP DELAY IN SECONDS.” Enter the time desired for the sampler to
become operational, before the actual sampling period begins (typically 2 seconds).

1
0.

Screen Prompt “KEYPAD SECURITY.” Select either “0” for OFF or “1” for ON, all keys on the
keypad are disabled except the “UNITS”, “START”, and “STOP” keys.

1.

Press START/STOP keys.

Prior to
Starting:

Start-up

Off:
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S4PE
GENERAL INFORMATION
Equipment Name:

Persistent Substance Sampling and Evaporation System

Model:

S4PE

Manufacturer:

Proengin, Inc. & Arrow-Tech, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

954-760-9990
eric.damiens@proengin.com
http://www.proengin.com
NOTE: Guides are to be used by trained personnel only. DO NOT
replace the manufacturer’s operations or technical manuals. These
guides were developed by field personnel for utilization by EPA and
their contractors and are helpful in quick start-up and operations.
Various limitations have been identified through the experience of
the development group. Different makes, models, and updates to this
equipment may change the limitations. It is recommended that
calibration, maintenance, and use be recorded in a logbook.
Additional product information may be found in the accompanying
Equipment Operating Guide.

SPECIFICATIONS
Uses:

The S4PE is used for sampling liquids or solids to allow the AP2C to analyze for the presence of
hazardous concentrations of nerve and mustard agents in liquid and vapor forms.

Limitations:

Only detects HD (sulfurated) blister agents, and GA, GB, and VX (phosphated) nerve agents.
May give false response in an enclosed space such as a maintenance shop or engine test bay;
downwind from, or in, dense smoke and fumes. Some of the vapors that may give a false response
are: wintergreen, peppermints, menthol cigarettes, cough lozenges, and smoke. The AP2Ce will not
detect nitrogen mustard, Lewisite, or irritants. The AP2Ce has not been tested against industrial or
household chemicals found in the civilian environment. The instrument will not work properly above
10,000 feet in elevation or in Oxygen levels below 19%. The AP2Ce will operate between -10°C and
55°C. The AP2Ce requires the use of proprietary batteries and proprietary hydrogen cells. The
batteries and hydrogen cells will have to be shipped by air as dangerous goods.

Detection Limits:

(Based on AP2C) Vapors, Aerosols and Droplets:
All G agents (nerve) - 1.5 ppb (3 seconds)
HD (blister) - 60 ppb (5 seconds)
VX (nerve) – (5) seconds

Alarm Level:

Buzzer can be attached to the AP2C which will alarm at first visual signal (first red indicator light).

Product Safety:

Model AP2C is NOT intrinsically safe. Instrument contains a hydrogen storage device. DO NOT
SHIP THIS INSTRUMENT WITHOUT PROPER SHIPPING PAPERS. (UN=1049 “Hydrogen
compressed”.

Battery:

The S4PE uses a 3.5V lithium battery supplied with unit. It can provide sufficient charge 1,000
samples and can be stored up to 3 years.

Calibration Gas:

Field Calibration Not Required, this attachment is used to perform confidence test for the AP2C
before each use.
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S4PE
QUICK START SHEET
Prior to
Starting:

Start-up:

1.

Loosen the cap from the handle of the SP4E.

2.

Take an LSH20 type battery from the transport case and install it in the handle.

3.

Screw up the cap on the handle of the S4PE.

1.
Take a scraper bar from its pack.
2.

Release ONE SINGLE SCRAPER from the bar holding the protective band.

3.

Place the nose of the S4PE facing the scraper to be installed (as illustrated in the top left
schematic under the General Information section).

4.

Force the nose end of the S4PE into the opening of the scraper. Take the scraper out of its pack.
For detecting persistent products, replace the sampling nozzle by the sampling pipe combined
with the use of the S4PE.

1.

To test the operation of the AP2C: Equip AP2C with sampling pipe, and Equip S4PE with a
TEST SCRAPER: BLUE.

2.

When the AP2C is operational, green “READY” light flashing, insert and hold the nose of the
S4PE in the sampling pipe of the AP2C (keep the S4PE perpendicular to the AP2C).

3.

Apply continuous pressure (about 15 to 20 sec.) To the push-button of the S4PE to control the
heating of the “TEST” scraper. The red light of the S4PE comes on.

4.

The lights (G, V-HD, V) of the display unit should come on. From detection, stop pressure to
the push-button of the S4PE to avoid the AP2C saturation.

Zero:

1.

Not applicable.

Calibration:

1.

Field Calibration Not Required, this attachment used to perform confidence test for the AP2C
before each use.

Turn Off:

1.

The nose of the AP2C, nozzle, or sampling pipe are uncoupled by pulling them directly apart.

2.

During storage, the gas sampling nozzle is in place on the nose of the AP2C.

3.

To eject a scraper from the S4PE, push the nose of the S4PE towards the scraper.

Confidence
Test
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SAM 935 Gamma Spectrometer and Radiation Survey Meter
GENERAL INFORMATION
Equipment Name:

Isotopic Surveillance & Measurement System (γ Spectrometer)

Model:

SAM 935 (Original Software and Hardware – Firmware Version 02.11.01)

Manufacturer:

Berkeley Nucleonics Corporation

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

2955 Kerner Blvd, Suite D, San Rafael, CA 94901

800-234-7858; 415-453-9955; 415-453-9956 (fax)
bernadette.murphy@berkeleynucleonics.com
http://www.berkeleynucleonics.com
NOTE: Guides are to be used by trained personnel only
and DO NOT replace the manufacturer’s operations or
technical manuals. These guides were developed by
field personnel for utilization by EPA and their
contractors and are helpful in quick start-up and
operations. Various limitations have been identified
through the experience of the development group.
Different makes, models, and updates to this equipment
may change the limitations. It is recommended that
calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found
in the accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

To provide field surveillance and measurement of multiple radioactive nuclides by identifying
signature γ radiation energies by spectrometry and matching them to a database of nuclide energies
in the unit’s memory, thereby identifying the isotopes present.

Limitations:

Cannot identify α or β emitting isotopes, but will identify γ emitting daughter products. The SAM
may not work at temperatures below -40°F. Quick changes in temperature can adversely affect
SAM readings, It is important to calibrate the instrument using quick calibration. The neutron
detector must be purchased to detect special nuclear material. When in manual mode and user
deletes data using the F3 key, no warning is given prior to deletion. The SAM will give an
inaccurate reading while experiencing high level of stimulation.

Response Range:

0.01 μR/hr - 99.0 R/hr.

Alarm Level:

Adjustable alarm levels for both dose and dose rate. Beep and illuminated alarm light upon
exceeding alarm threshold. Adjustable spectrum capture trigger criteria for isotopes.

Product Safety:

Intrinsically safe.

Battery:

Internal trickle-charged battery with a battery life of approximately 8 hours. The battery should be
charged once a month. May be run off of direct power using the supplied adapter.

Calibration:

Fine calibration performed annually by manufacturer. Gross calibration required and background
spectrum capture required prior to every use and periodically during use. It is the responsibility of
the user to ensure the calibration/service documentation is present or available. Do not use unit if
calibration documentation is missing, unknown, or out of date.

Additional
Operating
Information:

Selecting specific isotopes from the library to monitor:
1. Press UTIL button, select “Area Monitor Set-up,” select triggers.
2. Scroll to “unused”, select F2 (isotope).
3. Scroll to isotope you wish to monitor and press Enter. Press F1 to return to Dose Rate Screen.
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SAM 935 Gamma Spectrometer and Radiation Survey Meter
QUICK OPERATIONS GUIDE
Turn On:

1.

Using the connection cable, connect the probe to the unit. Do not force the plug into place.
Power on the SAM 935 by pressing the ON/OFF Button behind the sliding door in the upper left
corner of the instrument. Allow the instrument to perform self-test and stabilize the NaI
detector. This self test takes about 5 minutes to perform. Do not interrupt the sequence by
shutting the unit off or aborting the startup (do not press OK (F2 button). The initial screen will
display the date/time; pass or fail the “self-test” along with the status of the battery, Internal NaI,
Internal He3, System memory, Spectrum Memory. A countdown will be displayed on the screen
and the instrument will automatically prompt the operator to begin a “gross” calibration once this
detector stabilization process is complete.

Gross
Calibration:

1.

Once prompted to begin calibration, press the F3 Button (ADJUST) to perform the calibration.
Follow on-screen prompt to place the Cs137 source on the detector and press F2 Button (OK).

2.

After the calibration spectrum is captured, the unit will beep twice and prompt the operator to
take a background spectrum. The Screen will display wait time ~ 1 min. Remove the Cs137
check source and press the F2 Button (BKG) and allow the unit to acquire the background
spectrum. The screen will display a wait time of 1 minute. Once complete the unit will enter
and display the Surveillance Mode. Unit is now ready for operation.

1.

In the Surveillance Mode, a continuously monitored dose rate will be displayed, a cumulative
dose shown, and the unit will analyze for possible isotopic contributions to the overall dose rate.
When any preset triggers are exceeded, the unit automatically saves and reports alarm condition.

2.

When the unit reports an alarm condition, the suspect isotope (i.e. Cs137, Tc99m) will be listed
on the screen with its contribution to the total dose rate. If the isotope cannot be matched to the
library spectrum, “Unidentified” will be displayed with its contribution to dose rate.

1.

In Surveillance Mode, press the F1 Button (MONITOR) to see the bar graphs of each enabled
isotope in the library. The bar graphs show detector response above background in number of
sigma (standard deviations) above background for the listed isotopic peak gamma energies.

2.

When in Monitoring Mode and the preset triggers are exceeded, the isotope bar will begin
flashing and the word ALARM will be shown with the sigma value. This data and the spectra
will be stored in memory.

1.

In Monitoring Mode, press the F1 Button (DETAIL) to watch the gamma spectrum building.
This will allow the operator to verify the existence of distinguishing peaks during alarms.

2.

When the alarm is triggered, press the F3 Button (CAPTURE) to manually capture a spectrum of
the incoming gamma energies. The unit will automatically store all alarm conditions, so this
procedure is not required to collect and store this alarm data.

Reviewing
and Printing
Alarms:

1.

In any operating mode, pressing the Right/Left Arrow will allow cycle through all stored and
captured alarms. If the SAM is connected to the printer via the serial port during this review of
the stored alarms, pressing the F3 Button (PRN SEL) will print the stored data for analysis.
Pressing the F4 Button (MCA) will allow you to match stored spectra against the isotope library
signature peaks. User may print, using the supplied printer and cable, to print the results.

Turn Off:

1.

Ensure unit in Surveillance or Monitor Mode, press the ON/OFF Button. Unit will power down
and all data will be saved.

Advanced
Features:

1.

For more thorough discussion of the advanced features of this instrument, such as the Manual
Multi-Channel Analysis (MCA) please see the EOG. Additional functions and operations can
also be found in the user’s manual.

Surveillance:

Monitoring:

Detail:
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GENERAL INFORMATION
Equipment Name:

Isotopic Surveillance & Measurement System (γ Spectrometer)

Model:

SAM 935 (v11)

Manufacturer:

Berkeley Nucleonics Corporation

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

2955 Kerner Blvd, Suite D, San Rafael, CA 94901

800-234-7858; 415-453-9955; 415-453-9956 (fax)
bernadette.murphy@berkeleynucleonics.com
http://www.berkeleynucleonics.com
NOTE: Guides are to be used by trained personnel only
and DO NOT replace the manufacturer’s operations or
technical manuals. These guides were developed by
field personnel for utilization by EPA and their
contractors and are helpful in quick start-up and
operations. Various limitations have been identified
through the experience of the development group.
Different makes, models, and updates to this equipment
may change the limitations. It is recommended that
calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found
in the accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

To provide field surveillance and measurement of multiple radioactive nuclides by identifying
signature γ radiation energies by spectrometry and matching them to a database of nuclide
energies in the unit’s memory, thereby identifying the isotopes present.

Limitations:

Cannot identify α or β emitting isotopes, but will identify γ emitting daughter products. The SAM may
not work at temperatures below -40°F. Quick changes in temperature can adversely affect SAM
readings, The neutron detector must be purchased to detect special nuclear material. When in manual
mode and user deletes data using the F3 key, no warning is given prior to deletion. The SAM will give
an inaccurate reading while experiencing high level of stimulation.

Response Range:

0.01 μR/hr - 99.0 R/hr.

Alarm Level:

Adjustable alarm levels for both dose and dose rate. Beep and illuminated alarm light upon
exceeding alarm threshold. Adjustable spectrum capture trigger criteria for isotopes.

Product Safety:

Intrinsically safe.

Battery:

Internal trickle-charged battery with a battery life of approximately 8 hours. The battery
should be charged once a month. May be run off of direct power using the supplied adapter.

Calibration:

Fine calibration performed annually by manufacturer. It is the responsibility of the user to
ensure the calibration/service documentation is present or available. Do not use unit if
calibration documentation is missing, unknown, or out of date.

Additional
Operating
Information:

Selecting specific isotopes from the library to monitor:
1. Press UTIL button, select “Area Monitor Set-up”, select triggers.
2. Scroll to “unused”, select F2 (isotope).
3. Scroll to isotope you wish to monitor and press Enter. Press F1 to return to Dose Rate
Screen.
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SAM 935 Gamma Spectrometer and Radiation Survey Meter
QUICK OPERATIONS GUIDE
Turn On:

1.

Using the connection cable, connect the probe to the unit. Do not force the plug into place. Power on
the SAM 935 by pressing the ON/OFF Button behind the sliding door in the upper left corner of the
instrument. Allow the instrument to perform self-test and stabilize the NaI detector. This self test
takes about 5 minutes to perform. Do not interrupt the sequence by shutting the unit off or aborting
the startup (do not press OK (F2 button). The initial screen will display the date/time; pass or fail the
“self-test” along with the status of the battery, Internal NaI, Internal He3, System memory, and
Spectrum Memory. The SAM possesses an internal Cs-137 source that usually allows it to calibrate
itself during startup. In some circumstances, the SAM may prompt the user for a “gross” calibration
using an external Cs-137 source. If a gross calibration is required, see below, if not proceed to the
Dose Rate section below.

Gross
Calibration:

1.

Once prompted to begin calibration, press the F3 Button (ADJUST) to perform the calibration.
Follow on-screen instructions to place the Cs137 check source on detector and press F2 Button (OK).

2.

After the calibration spectrum is captured, the unit will beep twice and prompt the operator to take a
background spectrum. The Screen will display wait time ~ 1 min. Remove the Cs137 check source
and press the F2 Button (BKG) and allow the unit to acquire the background spectrum. The screen
will display a wait time of 1 minute. Once complete the unit will enter and display the Surveillance
Mode. Unit is now ready for operation.

1.

In the Dose Rate Mode, a continuously monitored dose rate will be displayed, a cumulative dose is
shown, and the unit will analyze for possible isotopic contributions to the overall dose rate. When
any preset triggers are exceeded, the unit will automatically save and report the alarm condition.

2.

When the unit reports an alarm condition, the suspect isotope (i.e. Cs137, Tc99m) will be listed on
the screen with its contribution to the total dose rate. If the isotope cannot be matched to the library
spectrum, “Unidentified” will be displayed with its contribution to dose rate.

1.

In Dose Rate Mode, press the F1 Button (Sigma) to see the bar graphs of each enabled isotope in the
library. The bar graphs show detector response above background in number of sigma (standard
deviations) above background for the listed isotopic signature peak gamma energies. An isotope
must be in the trigger list to appear during a search. The components of the trigger lists are available
for examination in the Utilities menu.

2.

When in Sigma Mode and the preset triggers are exceeded, the isotope bar will begin flashing and the
word ALARM will be shown with the sigma value. This data and the spectra will be stored in
memory. Note that alarms are stored until manually deleted by the user.

1.

In Sigma Mode, press the F1 Button (DETAIL) to watch the gamma spectrum building. This will
allow the operator to verify the existence of distinguishing peaks during alarms.

2.

When the alarm is triggered, press the F3 Button (CAPTURE) to manually capture a spectrum of the
incoming gamma energies. The unit will automatically store all alarm conditions, so this procedure is
not required to collect and store this alarm data.

Reviewing
and Printing
Alarms:

1.

In any operating mode, pressing the Right/Left Arrow will allow cycle through all stored and
captured alarms. If the SAM is connected to the printer via the serial port during this review of the
stored alarms, pressing the F3 Button (PRN SEL) will print the stored data for analysis. Pressing the
F4 Button (MCA) will allow you to match stored spectra against the isotope library signature peaks.
User may print, using the supplied printer and cable, to print the results.

Turn Off:

1.

Ensure unit in Dose Rate or Sigma Mode, press the ON/OFF Button. Unit will power down and all
data will be saved.

Advanced
Features:

1.

For more thorough discussion of the advanced features of this instrument, such as the Manual MultiChannel Analysis (MCA) please see the EOG. Additional functions and operations can also be found
in the user’s manual.

Dose Rate:

Sigma:

Detail:
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SKC Universal Sampler Pump
GENERAL INFORMATION
Equipment Name:

Universal Sampler Pump

Model:

PCXR8

Manufacturer:

SKC Inc.

Manufacturer
Contact:

Telephone: 800-752-8472
E-mail:
skctech@skcinc.com
Website:
http://www.skcinc.com
NOTE: Guides are to be used by trained personnel only and DO
NOT replace the manufacturer’s operations or technical manuals.
These guides were developed by field personnel for utilization by
EPA and their contractors and are helpful in quick start-up and
operations. Various limitations have been identified through the
experience of the development group. Different makes, models, and
updates to this equipment may change the limitations. It is
recommended that calibration, maintenance, and use be recorded in a
logbook. Additional product information may be found in the
accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

Suitable for a broad range of applications in air monitoring including industrial hygiene studies and
environmental testing.

Limitations:

Time consuming sampling procedure.
Automatic fault shutdown due to excessive restricted flow or low batteries voltage may cause that
collected on sampling media air volume is less than require for analytical method.
Temperature of operation: -20°C – 45°C (-4°F –113°F).

Battery:

6.0 V plug-in Ni-Cad rechargeable batteries. Fully charged batteries allow pump operation for
approximately 8 hours. It is important to charge the batteries before sampling; using the SKC
approved charger.

Calibration:

High flow rate calibration:
Connect the 1/4-inch Tygon tubing with the sampling medium to the pump intake. Start the pump
using the on/off switch and press the Start/Hold button, press the Flow and Battery Check.
Adjust the flow using the flow adjust screw until the build-in-rotameter reads 2 L/min. The LCD
should indicate BATT OK (if not recharge battery). Press Flow and Battery Check to place the pump
in Hold. Connect the flow meter (BIOS Calibrator) to the intake of the sampling medium, press Flow
and Battery Check, and set the flow rate by turning the flow adjust screw.
Low flow rate calibration:
Connect the 1/4 inch Tygon tube, low flow holder, and sorbent tube with the arrow pointing towards
rubber sleeve. Start the pump using the on/off switch and press the Start/Hold button, press the Flow
and Battery Check. Adjust the flow by turning the flow adjust screw until build in rotameter reads 1.5
L/min. Connect the flow meter to the exposed end of the sorbent tube. Connect the flow meter (BIOS
Calibrator) to the intake of the sampling medium, press Flow and Battery Check, and set the flow rate
by turning the flow adjust screw.

Additional
Operational
Information:

Built-in pressure regulator allows user to take up to 4 simultaneous tubes at different
flow rates using optional adjustable flow holder. Intrinsically safe.
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SKC UNIVERSAL SAMPLER PUMP
QUICK START GUIDE
Start-up:

Off:

1.

Charge the batteries by connecting the charger plug to the sampler charging jack.

2.

Set the flow rate:
High flow application:
Set the high flow rate by turning the regulator screw clockwise until it stops.
Adjust the flow by turning the flow adjust screw until build in rotameter reads 1.5 L/min.
Start the pump using the on/off switch.
Perform calibration for the high flow rate.
Low flow application:
Start the pump using on/off switch.
Press the Flow and Battery Check key.
Adjust the flow by turning the flow adjust screw until build in rotameter reads 1.5 L/min.
The LCD screen should indicate Battery OK, than press the Flow and Battery Check.
Turn the regulator valve screw counterclockwise four and half turns.
Perform calibration for the low flow rate.

3.

Programming:
To enter Delayed Start Mode: From Hold press Set up and enter the number of minutes
delay by pressing Digit Select and Digit Set. The Digit Select key advances the flashing
digit and the Digit Set increases the value of flashing digit.
To enter Sample Period Mode: Press Mode than Digit Select and Digit Set to
enter sampling time period.
To enter Pump Period Mode: Press Mode and use the Digit Select key and the
Digit Set key to enter the actual time of running the pump.

4.

While the LCD displays “Hold” start the sampling by pressing Start/Hold. If the pump is
programmed to the delayed start mode, LCD will show time remained until sampling starts.

1.

Before shut down the pump, note the total running time, connect the flow meter (BIOS Dry Cell
Calibrator) and check the final flow. Turn off the pump by sliding the switch to Off position.
Calculate the average flow and total air volume collected on sampling media.

High Flow Calibration

Low Flow Calibration
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Single Point Monitor (SPM) Tape Gas Monitor
GENERAL INFORMATION
Equipment Name:

SPM Chemical Tape Monitor

Model:

SPM

Manufacturer:

MDA Scientific, Zellweger Analytics (Honeywell Analytics)

National
Manufacturer
Contact:

Telephone:
Website:

847-634-2840
http://www.honeywellanalytics.com

NOTE: Guides are to be used by trained personnel only and DO NOT
replace the manufacturer’s operations or technical manuals. These guides
were developed by field personnel for utilization by EPA and their
contractors and are helpful in quick start-up and operations. Various
limitations have been identified through the experience of the development
group. Different makes, models, and updates to this equipment may change
the limitations. It is recommended that calibration, maintenance, and use be
recorded in a logbook. Additional product information may be found in the
accompanying Equipment Operating Guides.

SPECIFICATIONS
Uses:

Sampling and recording of concentrations of various airborne chemicals (see manufacturer’s
data for analyte listing) Monitoring is possible for 15 or 30 days depending on tape used.

Limitations:

1. Requires use of chemical specific tape (which have limited shelf life) and “ChemKeys,”.
3. Requires 120 volt power, and weather protection for extended use
4. Gas to be monitored must be known so appropriate tape and key can be installed
5. Some tapes require refrigeration or freezer storage and are light sensitive.
6. Heavy, bulky and shock sensitive.

Response Range:

Varies by chemical monitored - set by ChemKey used

Alarm Level:

Varies by chemical monitored - set by ChemKey used

Product Safety:

This instrument is not intrinsically safe.

Battery:

Fresh, fully charged internal battery should provide 8 hours of operation, but frequent alarms
will shorten operating times. The message “BATT LOW appears when there is 60 to 90
minutes of run time is left on the batteries.120 volt power will need to be supplied to unit
through the charger for longer term operation. Batteries not easily field replaceable. When not
in use, should remain on charge at all times.

Calibration:

Not required in field - determined by ChemKey used.

Additional
Information:

1. Unit will not operate without ChemKey installed.
2. Make sure Chemcassette® tape is not past expiration date.
3. Do not use in direct sunlight, temps above 104ΕF, or below 32ΕF.
4. Some humidity necessary for proper operation.
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Single Point Monitor (SPM) Tape Gas Monitor
QUICK OPERATIONS GUIDE
Start Up:

1.

Installation of
Sample &
Exhaust
Tubing:

Installation of
Chemcassette
Tape:

Running Unit:

Fully charge battery or connect external power, and make sure that the correct ChemKey is
installed before turning unit on. Activate ChemKey by inserting ChemKey into ChemKey
slot and turning 1/4 turn clockwise.
Note: Use 1/8" ID, 1/4" OD FEP Teflon tubing at sample inlet to avoid possible sample
interference and incorrect readings. Sample inlet tubing length may be limited for some
target gasses - see sec. 4.10 in manual for more info.

1.

Insert sample tubing into sample inlet fitting [fig.1 (15,24)] - do not over tighten

2.

Connect any auxiliary devices.

1.

Open tape load lever [fig.1 (18)] – if unit is on, the green system status LED will flash slowly.

2.

Remove center retaining screw and remove old Chemcassette® [fig.1 (4)] if present. Install
new Chemcassette® (make sure chemical tape is not expired) with raised lettering facing up.

3.

Pull 12" of tape off new cassette and place end in take-up reel cover [fig.1 (27)].

4.

Thread tape through detector head, capstan assembly, and over the guide posts [fig.1
(7,17,25,26)], and install the take-up reel cover.

5.

Rotate take-up reel to remove slack and re-install retaining screw in center of Chemcassette®
tape.

6.

Close the tape load lever – if unit is on, monitoring will begin automatically and green
LED[fig.1 (9)] will be lit

1.

Turn on main power [fig.1 (8)] , and check display [fig.1 (19)]to verify “Gas Type”, “Alarm
Levels”, and “Chemcassette Type”.

2.

Leak test unit by plugging end of sample line. A “FAULT #17” message will be displayed,
indicating that there are no leaks between the sampling point and SPM. Press “ALARM
RESET” key to reset pump.

3.

Unit will go into sampling mode automatically following leak test as indicated by green LED

4.

The unit may be turned off at any time. Remove Chemcassette® and double bag in a plastic
bag to preserve sample. Remove ChemKey and store in instrument case.
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Single Point Monitor (SPM) Tape Gas Monitor
Figure 1
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TVA-1000B Toxic Vapor Analyzer (PID/FID)
GENERAL INFORMATION
Equipment Name:

TVA-1000 Toxic Vapor Analyzer

Model:

1000B

Manufacturer:

Thermo Fisher Scientific, Inc.

National
Manufacturer
Contact:

Telephone:
E-mail:
Website:

888-643-4968
lori.gorski@thermofisher.com
http://www.thermofisher.com
NOTE: Guides are to be used by trained
personnel only and DO NOT replace the
manufacturer’s
operations
or
technical
manuals. These guides were developed by field
personnel for utilization by EPA and their
contractors and are helpful in quick start-up and
operations. Various limitations have been
identified through the experience of the
development group. Different makes, models,
and updates to this equipment may change the
limit-ations. It is recommended that calibration, maintenance, and use be recorded in a
logbook. Additional product inform-ation may
be found in the accompanying Equipment
Operating Guide.

SPECIFICATIONS
Uses:

Limitations:

Response
Range:

The TVA-1000 Toxic Vapor Analyzer, shown above, is an organic / inorganic vapor monitor for the
gas survey industry This analyzer uses either a flame ionization detector (FID), a photo-ionization
detector (PID), or both. The vapor concentration may be read immediately on either of two displays —
one mounted directly on the hand-held sample probe and the other on the instrument sidepack itself.
Vapor concentration can be displayed on both displays in either parts per million (ppm), parts per
billion (ppb), or percent concentration (%).
1. The FID requires >16% oxygen to maintain the hydrogen flame. If there is not sufficient
amount of oxygen, the flame will go out.
2. Neither detector is compound specific. PID is calibrated to isobutylene. The FID is calibrated
to methane. Other compounds have different response factors for each detector.
3. Low oxygen can also effect the characteristics of the flame, causing false elevated readings.
4. If the ionization potential of a compound is higher than the lamp energy, the compound may
not be detected.
5. PID has a smaller dynamic range, and is not the best choice for measuring high concentrations
of vapors.
6. PID is susceptible to interference from water vapor more so than the FID.
7. As the unit ages, the PID lamp energy may decrease, so compounds with ionization energy
near the lamp energy may not be detected.
8. PID lamp requires periodic cleaning depending on operating conditions.
9. Detection of chemical warfare agent vapors is unreliable, even if instrument is calibrated.
10. Must follow proper shipping instructions due to the hydrogen tank. The hydrogen storage tank
needs to be shipped as dangerous goods. Air Cargo Only 1049 “Hydrogen, Compressed”.
PID Instrument: 0.5 - 2,000 ppm isobutylene, accurate to 500 ppm isobutylene, Min.: 100 ppb benzene
FID Instrument 1.0 - 50,000 ppm methane, accurate to 10,000 ppm methane, Min: 300 ppb hexane
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Alarm
Level:

Set by user: High, Low, STEL.

Product
Safety:

FM: Intrinsically safe for Class 1, Division 1, Groups A, B, C and D. Hydrogen cylinders require
special shipping as dangerous goods, UN 1049.

Battery:

The TVA-1000B operates on a rechargeable nickel cadmium battery. When the battery is fully
charged, it will last a minimum of eight hours of continuous use at 20°C. Extreme temperatures, hot or
cold, and use of the backlight will shorten the run time. The battery does not need to be removed from
the instrument to be charged. A fully discharged battery will take approximately 16 hours to recharge
completely.

Calibration:

Annual Manufacturer Calibration, check calibration date on a tag or sticker. Capable of multipoint and
multiple response factors/curves calibrations. Instrument alerts user if calibration is bad.
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QUICK START GUIDE
Prior to
Starting:

Start-up

Calibration:

Turn Off:

1.

Charge battery. Connect sample probe. Fill/install hydrogen tank.

2.

Open the red hydrogen valve located on the side of the unit by turning the handle to the “ON”
position. Let unit sit for approximately 5 minutes, so hydrogen can stabilize in unit.

1.

Press “ON” button until unit beeps and “MAIN MENU” appears on screen.

2.

Press “CONTROL”.

3.

Press “3” to ignite FID. (unit should pause and two audible pops may be head, indicating flame
is lit) If ignition fails, wait 5 minutes, and then press “3” to ignite FID.

4.

Press “1” to initiate run. Press and hold “EXIT” to stop run and return to the “MAIN MENU”.

NOTE: Prior to performing calibration, the instrument must be on and warmed up for approximately
30 minutes. The pump must be ON, the PID lamp must be ON, and the FID must be ignited
throughout the warm-up period.
1.

Press “2” to enter Setup.

2.

Press “1” to Calibrate.

3.

Press “2” to enter span concentration. Enter the concentration of the span gas being used.
(1=Both, 2=PID, 3=FID) Use the “▲▼” keys to select units of measurement. (ppm, ppb, %)
and key in numbers using number keypad on unit. “”Press “ENTER” to accept.

4.

Press “3” to zero the unit. (1=Both, 2=PID, 3=FID)

5.

Press “1” to zero both the PID and the FID. Connect Zero Gas to probe or use ambient air.
Press “ENTER” to start. Wait for readings to stabilize and press “ENTER” to accept, and
follow the instructions on screen to save values.

6.

Press “4” = Span.

7.

Press “2” = PID, apply the appropriate span gas, 100 ppm Isobutylene to probe (using a clean
and labeled Tedlar bag) and then press “ENTER”, wait for reading to stabilize and press
“ENTER” to accept. Follow the instructions on screen to save values.

8.

Repeat step 6 & 7 choosing “3”=FID and using 100ppm Methane span gas instead of
Isobutylene.

9.

Press “EXIT” 2 times to return to the “MAIN MENU”.

10.

Press “1” = RUN, You are now in the “SURVEY MODE”.

11.

Press and hold “EXIT” to stop run and return to the “MAIN MENU”.

1.

Press and hold the “OFF” key until unit turns off.

2.

With FID versions you must also shut off the hydrogen valve so the tank does not deplete.
Removing hydrogen tank also reduces chances of hydrogen leaking from tank.
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